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Read This First

About This Manual

This manual describes SYS/BIOS, which is the Kernel component of TI-RTOS. SYS/BIOS is also called
"TI-RTOS Kernel" in some documents. This document was published in conjunction with the release of
SYS/BIOS 6.70, but it may be used with later versions of SYS/BIOS if changes to the software do not
cause this document to be incorrect.

SYS/BIOS gives developers of mainstream applications on Texas Instruments devices the ability to
develop embedded real-time software. SYS/BIOS provides a small firmware real-time library and easy-
to-use tools for real-time tracing and analysis.

Versions of SYS/BIOS prior to 6.30 were called DSP/BIOS.

Notational Conventions

This document uses the following conventions:

Program listings, program examples, and interactive displays are shown in a special typeface.
Examples use a bold version of the special typeface for emphasis.

Here is a sample program listing:

#i ncl ude <xdc/runtime/System h>

int main(){
Systemprintf("Hello World!\n");
return (0);

}

Square brackets ( [ and ] ) identify an optional parameter. If you use an optional parameter, you
specify the information within the brackets. Unless the square brackets are in a bold typeface, do not

enter the brackets themselves.

SPRUEX3V—June 2020 Read This First
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Related Documentation From Texas Instruments

See the detailed list and links in Section 1.6.

Related Documentation

You can use the following books to supplement this reference guide:

The C Programming Language (second edition), by Brian W. Kernighan and Dennis M. Ritchie,
published by Prentice-Hall, Englewood Cliffs, New Jersey, 1988

Programming in C, Kochan, Steve G., Hayden Book Company

Programming Embedded Systems in C and C++, by Michael Barr, Andy Oram (Editor), published by
O'Reilly & Associates; ISBN: 1565923545, February 1999

Real-Time Systems, by Jane W. S. Liu, published by Prentice Hall; ISBN: 013099651, June 2000

Principles of Concurrent and Distributed Programming (Prentice Hall International Series in
Computer Science), by M. Ben-Ari, published by Prentice Hall; ISBN: 013711821X, May 1990

American National Standard for Information Systems-Programming Language C X3.159-1989,
American National Standards Institute (ANSI standard for C); (out of print)

Trademarks

The Texas Instruments logo and Texas Instruments are registered trademarks of Texas Instruments.
Trademarks of Texas Instruments include: TI, Code Composer, Code Composer Studio, DSP/BIOS,
SPOX, TMS320, TMS320C54x, TMS320C55x, TMS320C62x, TMS320C64x, TMS320C67x,
TMS320C28x, TMS320C5000, TMS320C6000 and TMS320C2000.

Windows is a registered trademark of Microsoft Corporation.
Linux is a registered trademark of Linus Torvalds.

All other brand or product names are trademarks or registered trademarks of their respective companies
or organizations.
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About SYS/BIOS

This chapter provides an overview of SYS/BIOS and describes its relationship to TI-RTOS and other TI-
RTOS components.

Topic Page
11 Whatis SYS/BIOS ? . ... .ottt ittt ittt st enn s ennnrens 12
1.2 How are SYS/BIOS and TI-RTOSRelated? ..................... 13
1.3 How are SYS/BIOS and XDCtools Related? .................... 14
1.4 SYS/BIOS Packagesand APIs......................cc0vuunt. 19
1.5 Using C++withSYS/BIOS .............cciiiiiiiiiinrnnnnnnnns 22
16 ForMorelnformation ...............cciiiiiiiiiinnrennnrens 24
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11  What is SYS/BIOS?
SYS/BIOS is a scalable real-time kernel. It is designed for
applications that require real-time scheduling and synchronization
or real-time instrumentation. SYS/BIOS provides preemptive multi-
threading, hardware abstraction, real-time analysis, and
configuration tools. SYS/BIOS helps minimize memory and CPU
requirements on the target.
SYS/BIOS is the "TI-RTOS Kernel" component of the TI-RTOS
product. Both names refer to the same component. You may see the
"TI-RTOS Kernel" name in other documents and on Texas
Instruments websites. This new name does not require any code changes on your part; directory and
module names are not affected by this change.
You can install SYS/BIOS by installing TI-RTOS from the CCS App Center (choose Help > CCS App
Center in CCS) or by downloading and installing it as a standalone product. CCS v6.0 or higher is
required.
SYS/BIOS requires no up-front or run-time license fees.
SYS/BIOS provides the following benefits:
® Al SYS/BIOS objects can be configured statically or dynamically.
¢ To minimize memory size, the APls are modularized so that only those APIs that are used by the
program need to be bound into the executable program. In addition, statically-configured objects
reduce code size by eliminating the need to include object creation calls.
® Error checking and debug instrumentation is configurable and can be completely removed from
production code versions to maximize performance and minimize memory size.
® Almost all system calls provide deterministic performance to enable applications to reliably meet real-
time deadlines.
®* To improve performance, instrumentation data (such as logs and traces) is formatted on the host.
® The threading model provides thread types for a variety of situations. Hardware interrupts, software
interrupts, tasks, idle functions, and periodic functions are all supported. You can control the priorities
and blocking characteristics of threads through your choice of thread types.
¢ Structures to support communication and synchronization between threads are provided. These
include semaphores, mailboxes, events, gates, and variable-length messaging.
® Dynamic memory management services offering both variable-sized and fixed-sized block allocation.
® Aninterrupt dispatcher handles low-level context save/restore operations and enables interrupt
service routines to be written entirely in C.
® System services support the enabling/disabling of interrupts and the plugging of interrupt vectors,
including multiplexing interrupt vectors onto multiple sources.
12 About SYS/BIOS SPRUEX3V—June 2020
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1.2 How are SYS/BIOS and TI-RTOS Related?

TI-RTOS is a scalable, one-stop embedded tools ecosystem for Tl devices. It scales from a real-time
multitasking kernel (SYS/BIOS) to a complete RTOS solution including additional middleware
components and device drivers. By providing essential system software components that are pre-tested
and pre-integrated, TI-RTOS enables you to focus on differentiating your application.

SYS/BIOS is the "TI-RTOS Kernel" component of TI-RTOS. Both "SYS/BIOS" and "TI-RTOS Kernel"
refer to the same component. You may see the "TI-RTOS Kernel" name in other documents and on Texas
Instruments websites. This new name does not require any code or other changes on your part; directory
and module names are not affected by this change.

TI-RTOS is not installed automatically as part of the Code Composer Studio v6.0 installation. You can
install TI-RTOS from the CCS App Center (choose Help > CCS App Center in CCS). Choose the version
of TI-RTOS for your device family. If you use devices in multiple families, you can install multiple TI-RTOS
versions.

If you do not use CCS, you can download and install TI-RTOS as a standalone product. In addition to the
Texas Instruments Code Generation Tools, TI-RTOS includes support for the IAR and GNU tool chains.
You can also download and install SYS/BIOS as a standalone product without the other TI-RTOS
components.

TI-RTOS is provided with full source code and requires no up-front or runtime license fees.
The components of TI-RTOS are as follows. Some components are not available for all device families.

Table 1-1. TI-RTOS Components

TI-RTOS Component Name PDF Documentation Location
TI-RTOS Kernel SYS/BIOS SYS/BIOS (TI-RTOS Kernel) User’s Guide -- SPRUEX3
TI-RTOS Instrumentation UIA System Analyzer User’'s Guide -- SPRUH43
TI-RTOS Networking NDK TI Network Developer's Kit (NDK) Guide -- SPRU523

TI Network Developer's Kit (NDK) AP| Reference -- SPRU524
TI-RTOS File System FatFS Core SDK User's Guide (HTML file included in installation)
TI-RTOS USB USB stack USB Library User’s Guide (in Tl Resource Explorer)

USB Library API Guide (in Tl Resource Explorer)
TI-RTOS Drivers and Board  Drivers *Ware, TI Drivers Runtime API Reference (doxygen content in Tl
Initialization TI-RTOS examples Resource Explorer)

This document refers to the directory where SYS/BIOS is installed as the BIOS_INSTALL_DIR. If you
install SYS/BIOS as part of TI-RTOS, this directory will have a path similar to

C\til\tirtos_<target>_2 ## ##_##\ products\bi os_6_##_##_ ##, where C:\ti will be the directory
where you installed CCS, <t ar get > is the device family, and # is a digit in the version number. If you
installed SYS/BIOS as a standalone product, BIOS_INSTALL_DIR is the directory where you installed it.
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1.3
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How are SYS/BIOS and XDCtools Related?

XDCtools provides the underlying core tooling needed by TI-RTOS and its components, including
SYS/BIOS. You must have both XDCtools and SYS/BIOS installed in order to use SYS/BIOS.

XDCtools is installed automatically during the CCS installation.

If you install TI-RTOS or SYS/BIOS as a standalone product (outside of CCS), you will also need to
download and install XDCtools. The SYS/BIOS release notes provide information about the versions of
XDCtools that are compatible with your version of SYS/BIOS. If you install a new, standalone version of
SYS/BIOS, you may need to install a new version of XDCtools.

XDCtools is important to SYS/BIOS users because:

¢ XDCtools provides the technology that users use to configure the SYS/BIOS and XDCtools modules
used by the application. See Section 1.3.2.

¢ XDCtools provides the tools used to build the configuration file. This build step generates source
code files that are then compiled and linked with your application code. See Section 1.3.2.

¢ XDCtools provides a number of modules and runtime APIs that SYS/BIOS leverages for memory
allocation, logging, system control, and more. See Section 1.3.3.

XDCtools is sometimes referred to as "RTSC" (pronounced "rit-see"—Real Time Software Components),
which is the name for the open-source project within the Eclipse ecosystem for providing reusable
software components (called "packages") for use in embedded systems. For documentation about
XDCtools modules, see the online help within CCS. For information about packaging of reusable
software components and details about the tooling portion of XDCtools, see the RTSC-pedia web site.

SYS/BIOS as a Set of Packages

SYS/BIOS and XDCtools are sets of "packages," each of which delivers a subset of the product's
functionality. XDCtools uses a naming convention for packages to aid readability and to ensure that
packages delivered from different sources don't have namespace collisions that will pose problems for
the system integrator. If you are familiar with the Java package naming convention, you will find it to be
quite similar.

SYS/BIOS packages conform to this convention with names that consist of a hierarchical naming pattern;

each level is separated by a period ("."). Usually, the highest level of the name is the vendor ("ti"), followed
by the product ("sysbios"), and then followed by the module and submodule names (for example, "knl").

These names have the added benéefit of reflecting the physical layout of the package within the file system
where SYS/BIOS has been installed. For example, the ti.sysbios.knl package files can be found in the
following folder:

Bl OS_| NSTALL_DI R\ bi os_6_##_##\ packages\ti\sysbi os\ knl

See Section 1.4 for a partial list of the packages provided by SYS/BIOS and Section 1.3.3 for a partial list
of the modules provided by XDCtools.
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You can picture the architecture of the tools used to create applications as shown in the following figure.
The xdc.runtime package provided by XDCtools contains modules and APIs your application can use
along with the modules and APIs in SYS/BIOS.

xdc.runtime
Package

Texas
Instruments
compilers

SYS/BIOS

Packages

XDCtools

Microsoft
compilers

Other

Packages

(3rd Party)

other
compilers
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1.3.2 Configuring SYS/BIOS Using XDCtools

Configuration is an essential part of using SYS/BIOS and is used for the following purposes:

® It specifies the modules and packages that will be used by the application.

® It can statically create objects for the modules that are used by the application.

® It validates the set of modules used explicitly and implicitly to make sure they are compatible.

® It statically sets parameters for the system, modules, and objects to change their runtime behavior.

An application's configuration is stored in one or more script files with a file extension of *.cfg. These are
parsed by XDCtools to generate corresponding C source code, C header, and linker command files that

are then compiled and linked into the end application. The following diagram depicts a build flow for a
typical SYS/BIOS application.

USER BUILD

PACKAGE A

CONFIG QUTPUT

link

.out

The configuration (*.cfg) file uses simple JavaScript-like syntax to set properties and call methods
provided by objects. You can create and modify a configuration file in the following ways:

® Using the visual configuration tool (XGCONF) in CCS.
® Editing the text of the configuration in the cfg Script tab in the XGCONF editor in CCS.
® Editing the *.cfg file directly with a text editor.
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The following figure shows the XGCONF configuration tool in CCS being used to configure a static

SYS/BIOS Task instance. You can see this configuration for yourself in the "Static Example" SYS/BIOS

project template in CCS.

& staticcfg &0 = O | 5% Outline &2 | = O
[ - — T
SYS/BIOS' Scheduling ® Task - Instance Settings <~ & @ E:
Module Advanced type filter text
~ Tasks ~ Required Settings @ EIOS
@& Clock
m Handle  null @ Defaults
taskl .
Function taskQFxn @ Diags
o & Error
Priority 15 @ HeapBuf
Use the vital flag to prevent systemn exit until this thread exits & Hwi
[¥] Task is vital @ Idle
+ Stack Control ® Log
@& LoggerBuf
Stack size 1024 & Mailbox
Mai
Stack memory section  fartaskStackSection ® Main
& Memory
Stack pointer null & Program
Stack heap null ® Queue
& Semaphore
= Thread Context @ Swi
& SysMin
Argument 0 1 @® System
Argument 1 2 ® Task
) ) @ taski
Envirenment pointer  null ® taskl
SYS/BIOS | Task 2% |cfg Seript ® Text
The Task instance named "task0" set up in the configuration tool corresponds to the following
configuration script:
var Task = xdc.useMdul e('ti.sysbios. knl. Task"');
Task. nunPriorities = 16;
Task. i dl eTaskSt ackSi ze = 1024;
var tskParans = new Task. Par ams;
tskParanms. arg0 = 1;
tskParanms. argl = 2;
tskParams. priority = 15;
t skPar ans. stack = nul | ;
t skPar ans. st ackSi ze = 1024;
var taskO = Task.create(' & askOFxn', tskParans);
SPRUEX3V—June 2020 About SYS/BIOS 17
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1.3.3 XDCtools Modules and Runtime APIs

XDCtools contains several modules that provide basic system services your SYS/BIOS application will

need to operate successfully. Most of these modules are located in the xdc.runtime package in XDCtools.

By default, all SYS/BIOS applications automatically add the xdc.runtime package during build time.

The functionality provided by XDCtools for use in your C code and configuration file can be roughly

divided into four categories. The modules listed in the following table are in the xdc.runtime package,

unless otherwise noted.

Table 1-2. XDCtools Modules Using in C Code and Configuration

Category Modules Description

System Services System Basic low-level "system" services. For example, character output,
printf-like output, and exit handling. See Section 9.3. Proxies that
plug into this module include xdc.runtime.SysMin and
xdc.runtime.SysStd. See Section 6.3.

Startup Allows functions defined by different modules to be run before
main(). See Section 6.5.

Defaults Sets event logging, assertion checking, and memory use options for
all modules for which you do not explicitly set a value. See Section
7.7.1 and Section 9.5.1.1.

Main Sets event logging and assertion checking options that apply to your
application code.

Program Sets options for runtime memory sizes, program build options, and
memory sections and segments. This module is used as the "root"
for the configuration object model. This module is in the xdc.cfg
package. See Section 3.4.1, Section 6.4, and Section 7.3.2.

Memory Management  Memory Creates/frees memory heaps statically or dynamically. See Section
7.7.
Diagnostics Log and Allows events to be logged and then passes those events to a Log

Loggers handler. Proxies that plug into this module include
xdc.runtime.LoggerBuf and xdc.runtime.LoggerSys. See Section
9.2.1 and Section 3.6.4.

Error Allows raising, checking, and handling errors defined by any
modules. See Section 6.7 and Section 9.3.

Diags Allows diagnostics to be enabled/disabled at either configuration- or
runtime on a per-module basis. See Section 9.5.1.

Timestamp Provides time-stamping APls that forward calls to a platform-specific

and Providers time stamper (or one provided by CCS). See Section 5.5,

Text Provides string management services to minimize the string data
required on the target. See Section 6.8.

Synchronization Gate Protects against concurrent access to critical data structures. See
Section 4.3.

Sync Provides basic synchronization between threads using wait() and
signal() functions. See Section E.6.
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1.4 SYS/BIOS Packages and APIs
SYS/BIOS provides the following packages:

Table 1-3. Packages and Modules Provided by SYS/BIOS

Package Description See
ti.sysbios.family.* Contains target/device-specific functions. Section 8.5
ti.sysbios.gates Contains several implementations of the IGateProvider Section 4.3

interface for use in various situations. These include
GateHwi, GateSwi, GateTask, GateMutex, and

GateMutexPri.
ti.sysbios.hal Contains Hwi, Timer, Seconds, and Cache modules Section 8.2, Section 8.3,
Section 5.4, Section 8.4.
ti.sysbios.heaps Provides several implementations of the XDCtools IHeap Chapter 7

interface. These include HeapBuf (fixed-size buffers),
HeapMem (variable-sized buffers), and HeapMultiBuf
(multiple fixed-size buffers).

ti.sysbios.interfaces Contains interfaces for modules to be implemented, for -
example, on a device or platform basis.

ti.sysbios.knl Contains modules for the SYS/BIOS kernel, including Swi,  Chapter 3, Chapter 4,
Task, Idle, and Clock. Also contains modules related to Chapter 5
inter-process communication: Event, Mailbox, and
Semaphore.

ti.sysbios.utils Contains the Load module, which provides global CPU Section 9.2

load as well as thread-specific load.

Each SYS/BIOS package provides one or more modules. Each module, in turn, provides APls for
working with that module. APIs have function names of the form Module_actionDescription(). For
example, Task_setPri() sets the priority of a Task thread.

In order to use a module, your application must include the standard SYS/BIOS header file and the
header file for that module. For example:

#i ncl ude <xdc/std. h> /[* initializes XDCtools */
#i ncl ude <ti/sysbi os/BI CS. h> /[* initializes SYS/BICS */
#i nclude <ti/sysbios/knl/Task.h> /* initializes Task nodule */

The API functions provided by each module differ.

1.4.1 SYS/BIOS Object Creation

Several modules support the creation of instance objects. Such modules include Hwi, Task, Swi,
Semaphore, Mailbox, Queue, Event, Clock, Timer, and various types of Gate and Heap modules. For
example, the Task module allows you to create several Task objects. Each Task object corresponds to a
thread that has its own function, priority, and timing.
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Such instance objects can be created in the following three ways.

® Module_create() The create APIs require a heap to allow dynamic memory allocation of the object.
All module create functions require that an Error_Block structure be passed to the creation function.
For example, this code fragment creates and posts a Semaphore object:

#i ncl ude <ti/sysbi os/knl/Semaphore. h>
Semaphor e_Handl e semaphor e0;

Semaphor e_Par ans semaphor ePar ans;
Error Bl ock eb;

Error_init(&eb);
Semaphor e_Par anms_i ni t (&enmaphor ePar ans) ;
semaphore0 = Semaphore_create(0, &semaphoreParans, &eb);
i f (semaphore0 == NULL) {
}

Semaphor e_post (semaphor e0) ;

® Module_construct() The construct APIs must be passed an object structure instead of dynamically
allocating the object from a heap. Avoiding dynamic memory allocation helps reduce the code
footprint. Most Module_construct() APIs do not require an Error_Block; this also helps reduce the
code footprint. Some Module_construct() APIs may allocate memory internally. For example,
Task_construct() allocates a task stack if you do not provide one. For example, this code fragment
constructs and posts a Semaphore object:

#i ncl ude <ti/syshi os/knl/Semaphore. h>
Semaphore_Struct sermaphoreOStruct;
Semaphor e_Par ans semaphor ePar ans;

Senmaphor e_Par ans_i ni t (&enaphor ePar ans) ;
Semaphor e_construct ( &emaphore0Struct, 0, &semaphoreParans);

Semaphor e_post ( Senaphor e_handl e( &enmaphor e0St ruct) ) ;

® Static creation allows you to specify the object in the application’s *.cfg file. No heap is needed if
you are statically allocating objects. A structure for the object is added to the source file generated
for the configuration. See Chapter 2 for details about configuration. For example, the following *.cfg
statements configure a Semaphore object. The Semaphore would be posted with the same
Semaphore_post() call used with Semaphore_create().:

var semaphor eOParans = new Semaphore. Parans();
Pr ogram gl obal . semaphore0 = Semaphore. create(0, semaphoreOParans);

Statically created objects cannot be destroyed at runtime.

The TI-RTOS examples use the Module_construct() mechanism, which is a nice compromise between
static and dynamic creation. However, each style of object creation has its own pros and cons as listed
in Table 1-4.
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Table 1-4. Benefits of Various Object Creation Styles

Dynamic Module_create()

Dynamic Module_construct()

Static Configuration

Flexible vs. Fixed
Application

Programming
Flow

Dynamic Memory
Allocation

Flexible: dynamic object

Flexible: dynamic object creation

Fixed: no dynamic object

Code Footprint

Runtime Object
View (ROV)

creation and destruction and destruction creation or destruction
Simple Application must manage object Simple.
Structs (instead of just Handles). Application uses the *.cfg file
Most construct calls cannot fail to create objects.
(see specific APIs for details).
Yes Goal to minimize or eliminate Goal to minimize or eliminate
dynamic memory allocation dynamic memory allocation
Larger Smaller Smallest possible

Always works for created ROV does not show constructed  Always works for configured

objects objects that are embedded in an objects
application structure or on a stack.
Object Destruction Yes, with Module_delete() Yes, with Module_destruct() No

See Appendix C of this document and the TI-RTOS Kernel Documentation Overview (in
Bl OS_I NSTALL_DI R/ docs/ Docunent ati on_Over vi ew. ht M for more information.

Notice that each of the methods of object creation uses a Module_Params structure. These structures
contain instance configuration parameters to control how the instance behaves. For example, the
Semaphore_Params structure is defined by SYS/BIOS as follows:

typedef struct Semaphore_Parans { /'l Instance config-parans structure

I I nstance_Par ans *i nst ance; /1 Common per-instance configuration
Event Handl e event ; // Event instance to use if non-NULL
Ul nt event | d; /1 eventld if using Events

Semaphor e_Mde node; /1 Semaphore node: COUNTI NG or Bl NARY

} Senmaphor e_Par ans;

The following application code creates the Semaphore parameters structure, initializes the structure with
the default parameters, and sets the "mode" parameter to BINARY to specify that this is a binary
semaphore. Following this code, you would use either Semaphore_create() or Semaphore_construct()
to create an instance.

Semaphor e_Par ans semaphor ePar ans;

Semaphor e_Par ans_i ni t (& enaphor ePar ans) ;

senPar ams. node = Semaphor e_Mbyde_Bl NARY;

For information about the parameter structure and its individual parameters for any module, see the API
Reference Help System described in Section 1.6.1.
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1.4.2

1.5

151

152

POSIX Thread Support

SYS/BIOS also provides a subset of the POSIX thread (pthread) APIs. These include pthread threads,
mutexes, read-write locks, barriers, and condition variables. The pthread APIs can simplify porting
applications from a POSIX environment to SYS/BIOS, as well as allowing the same code to be compiled
torun in a POSIX environment and with SYS/BIOS. As the pthread APIs are built on top of the SYS/BIOS
Task and Semaphore modules, some of the POSIX APIs can be called from SYS/BIOS Tasks.

For details about the POSIX thread APls supported by SYS/BIOS, see the TI-POSIX User’s Guide in the
/ docs/ ti posi x/ User s_Gui de. ht nl file within the TI-RTOS Kernel installation. For more detail, see the
official POSIX specification and documentation of the generic POSIX implementation.

Using C++ with SYS/BIOS

SYS/BIOS applications can be written in C or C++. An understanding of several issues regarding C++
and SYS/BIOS can help to make C++ application development proceed smoothly. These issues concern
memory management, name mangling, calling class methods from configured properties, and special
considerations for class constructors and destructors.

SYS/BIOS provides an example that is written in C++. The example code is in the bigtime.cpp file in the
packages\ti\sysbios\examples\generic\bigtime directory of the SYS/BIOS installation.

Memory Management

The functions new and delete are the C++ operators for dynamic memory allocation and deallocation.
For Tl targets, these operators use malloc() and free(). SYS/BIOS provides reentrant versions of malloc()
and free() that internally use the xdc.runtime.Memory module and (by default) the
ti.sysbios.heaps.HeapMem module.

Name Mangling

The C++ compiler implements function overloading, operator overloading, and type-safe linking by
encoding a function's signature in its link-level name. The process of encoding the signature into the
linkname is referred to as name mangling.

Name mangling could potentially interfere with a SYS/BIOS application since you use function names
within the configuration to refer to functions declared in your C++ source files. To prevent name mangling
and thus to make your functions recognizable within the configuration, it is necessary to declare your
functions in an extern C block as shown in the following code fragment from the bigtime.cpp example:

/*
* Extern "C' block to prevent name nmangling
* of functions called within the Configuration Tool
*/
extern "C' {
/* Wapper functions to call Cdock::tick() */
voi d cl ockTask(d ock cl ock);
voi d cl ockPrd(d ock cl ock);
voi d cl ockl dl e(void);
} I/ end extern "C'

22
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This extern C block allows you to refer to the functions within the configuration file. For example, if you
have a Task object that should run clockTask() every time the Task runs, you could configure a Task as
follows:

var taskOParans = new Task. Parans();

t askOPar ans. i nst ance. nane = "task0";

t askOPar ans. arg0 = $externPtr("cl 3");

Program gl obal .t askO = Task. create("&cl ockTask", taskOParans);

Notice that in the configuration example above, the arg0 parameter of the Task is set to
$externPtr("cl 3"). The C++ code to create a global clock object for this argument is as follows:

/* d obal clock objects */

Clock cl3(3); /* task clock */

Functions declared within the extern C block are not subject to name mangling. Since function
overloading is accomplished through name mangling, function overloading has limitations for functions
that are called from the configuration. Only one version of an overloaded function can appear within the
extern C block. The code in the following example would result in an error.

extern “C { /| Exanpl e causes ERROR
Int addNunms(Int x, Int y);
Int addNunms(Int x, Int y, Int z); // error, only one version
/1 of addNuns is all owed

}

While you can use name overloading in your SYS/BIOS C++ applications, only one version of the
overloaded function can be called from the configuration.

Default parameters is a C++ feature that is not available for functions called from the configuration. C++
allows you to specify default values for formal parameters within the function declaration. However, a
function called from the configuration must provide parameter values. If no values are specified, the
actual parameter values are undefined.

1.5.3 Calling Class Methods from the Configuration
Often, the function that you want to reference within the configuration is the member function of a class
object. It is not possible to call these member functions directly from the configuration, but it is possible
to accomplish the same action through wrapper functions. By writing a wrapper function which accepts
a class instance as a parameter, you can invoke the class member function from within the wrapper.
A wrapper function for a class method is shown in the following code fragment from the bigtime.cpp
example:
| * ======== c| ockPrd ========
* Wapper function for PRD objects calling O ock::tick()
*/
voi d cl ockPrd(d ock cl ock)
{
clock.tick();
return;
}
Any additional parameters that the class method requires can be passed to the wrapper function.
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1.5.4 Class Constructors and Destructors
Any time that a C++ class object is instantiated, the class constructor executes. Likewise, any time that
a class object is deleted, the class destructor is called. Therefore, when writing constructors and
destructors, you should consider the times at which the functions are expected to execute and tailor them
accordingly. It is important to consider what type of thread will be running when the class constructor or
destructor is invoked.
Various guidelines apply to which SYS/BIOS API functions can be called from different SYS/BIOS
threads (tasks, software interrupts, and hardware interrupts). For example, memory allocation APls such
as Memory_alloc() and Memory_calloc() cannot be called from within the context of a software interrupt.
Thus, if a particular class is instantiated by a software interrupt, its constructor must avoid performing
memory allocation.
Similarly, it is important to keep in mind the time at which a class destructor is expected to run. Not only
does a class destructor execute when an object is explicitly deleted, but also when a local object goes
out of scope. You need to be aware of what type of thread is executing when the class destructor is called
and make only those SYS/BIOS API calls that are appropriate for that thread. For further information on
function callability, see the CDOC online documentation.
1.6  For More Information
You can read the following additional documents to learn more about TI-RTOS, SYS/BIOS, XDCtools,
and Code Composer Studio:
® SimpleLink SDK
— SimpleLink MCU SDK User's Guide (HTML file included in the SDK installation)
— TI Resource Explorer (online or installed within CCS) contains links to many other documents
® TI-RTOS Kernel (SYS/BIOS)
— Documentation Overview (Bl OS_I NSTALL_DI R/ docs/ Docunent ati on_Overvi ew. ht ni )
— TI's E2E Community lets you submit your questions.
— TI-RTOS Kernel Product Folder on Tl.com
— Embedded Software Download Page
¢ XDCtools
— RTSC-Pedia Wiki
— Embedded Software Download Page
® Code Composer Studio (CCS)
— CCS online help. Choose Help > Help Contents in CCS.
— Code Composer forum on TI's E2E Community
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1.6.1 Using the API Reference Help System
The API Reference help for TI-RTOS, SYS/BIOS, and the other TI-RTOS components is called "CDOC".

1. Open Tl Resource Explorer either within CCStudio or online.

2. Expand Software then the tree for your version of the Documentation Overview
SimpleLink SDK. Open Documents then Documentation
Overview. +| all packages

Il modul

3. In the Kernel Documentation section, click the link for the TI- I a[gn;uu =

RTOS Kernel Runtime APIs and Configuration (cdoc). =T
Iar

4. Click "+" next to arepository to expand its list of packages. Click o] @ ti
"+" next to a package name to see the list of modules it + # platforms
provides. Select a package or module to see its reference = =vebios
information.

+ E} family
In addition to the SYS/BIOS modules, this list includes all the + ff gates
modules provided by TI-RTOS, the TI-RTOS components that are + B hal
available for your device family, and XDCtools. ¥ B} heaps

+

The SYS/BIOS configuration property and C API documentation is f interfaces

within the "ti.sysbios" package. To view reference documentation = H knl
on memory allocation, logs, timestamps, asserts, and system, ® Clock
expand the "xdc.runtime" package. & Event
@ Idle
Each reference page is divided into two main sections: @ Mailbox
® CReference. This section has blue table borders. It begins with @ Queue
a table of the APIs you can call from your application’s C code. @ Semaphore
It also lists C structures, typedefs, and constants that are & Swi
defined by including this module’s header file. A description of @ Task

the module’s use follows; often this includes a table of the .
H} posix

calling contexts from which each API can be called. Detailed -
syntax for the functions, typedefs, structures, and constants + £ rom
follows. T B rts

¢ Configuration Reference. This section has blue-gray table 2 8 usle
borders. You can jump to this section in any topic by clicking the “ EH_}S
Configuration settings link near the top of the page. This $ Build
section provides information you can use when you are T 1 targets
configuring the application in the *.cfg file (either using + (# xdc

XGCONF or editing the source code for the configuration file

directly). This section lists the types, structures, and constants defined by the module. It also lists
parameters you can configure on a module-wide basis, and parameters that apply to individual
instances you create.

The Documentation Overview in the TI Resource Explorer provides a number of other links, including
a link to the Tl Drivers Runtime APIs reference documentation.

If you installed SYS/BIOS as a standalone tool, you can open the online help for SYS/BIOS by opening
the BI OS_|I NSTALL_DI R\ docs\ Bi os_API s. ht nl file in a web browser.

SPRUEX3V—June 2020 About SYS/BIOS 25
Submit Documentation Feedback


http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SPRUEX3V
https://dev.ti.com/tirex/#/
http://www.ti.com

I3 TEXAS
INSTRUMENTS Chapter 2

SPRUEX3V—June 2020

SYS/BIOS Configuration and Building

This chapter describes how to configure and build SYS/BIOS applications.

Topic Page
2.1 Creating a SYS/BIOS Project with the Tl Resource Explorer ... ... 27
2.2 Adding SYS/BIOS Support to an Existing Project . .............. 28
2.3 Configuring SYS/BIOS Applications .. ........................ 29
2.4 Building SYS/BIOS Applications . . . . ............ ... .. ... ... 41
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21 Creating a SYS/BIOS Project with the Tl Resource Explorer

The steps for creating a SYS/BIOS example project differ depending on which product package you

installed:

Processor SDK: For example, for C665x targets. Refer to the PDK documentation.

SimpleLink SDK: For example, for CC32xx targets. Refer to the SDK documentation.

TI-RTOS: For example, TI-RTOS for Tiva. Refer to the TI-RTOS documentation.

Standalone SYS/BIOS: Follow these steps:

1. In Code Composer Studio, choose Project > New > CCS Project.

2. Inthe New CCS Project Wizard, select your target. Then, under Project templates and examples,
select one of the SYS/BIOS examples. A description of the selected example is shown to the right of
the example list.

To get started with SYS/BIOS, you can choose one of the Generic Examples, such as the Log
Example or Task Mutex Example. When you are ready to create a production project, you might
choose the "Minimal" or "Typical" example depending on how memory-limited your target is. For
some device families, device-specific SYS/BIOS examples are also provided.

3. Click Finish. You can expand the project to view or change the source code and configuration file.

[{* Project Explorer &3
. 1= gpicinterrupt
v = task [Active - Debug]
ml! Includes
== Debug
lg] mutex.c
a1 TM5320F2838K.cmd
rmakefile.defs
mutex.cfg

4. Build the project using CCS. If you want to change any build options, right click on the project and
select Properties from the context menu. For example, you can change compiler, linker, and RTSC
(XDCtools) options.

Create a Target Configuration within CCS. Launch the configuration and connect to your target.
6. Launch a debug session for the project in CCS and switch to the CCS Debug perspective.
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2.2 Adding SYS/BIOS Support to an Existing Project

If you created a SYS/BIOS project using the Tl Resource Explorer, a configuration file is automatically
added to your project and SYS/BIOS support is automatically enabled.

Note: Applications that can use SYS/BIOS are referred to as having RTSC support enabled.
RTSC is Real-Time Software Components, which is implemented by the XDCtools
component. See Section 1.3 for details.

If you start with an empty CCS project template, you can add a configuration file for use with SYS/BIOS
to your CCS project by choosing File > New > RTSC Configuration File. If the project does not have
RTSC support enabled, you will be asked if you want to enable RTSC support for the current project.
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2.3

Configuring SYS/BIOS Applications

You configure SYS/BIOS applications by modifying the *.cfg configuration file in the project. These files
are written in a scripting language that is a superset of JavaScript. While you can edit this file with a text
editor, CCS provides a graphical configuration editor called XGCONF.

XGCONF is useful because it gives you an easy way to view the available options and your current
configuration. Since modules and instances are activated behind-the-scenes when the configuration is
processed, XGCONF is a useful tool for viewing the effects of these internal actions and for detecting
conflicts.

For example, the following figure shows the XGCONF configuration tool in Code Composer Studio used
to configure a static SYS/BIOS Swi (software interrupt) instance.

' TIResource Explorer & *mutexcfg 2 = B

4

» TI-RTOS * Products * SYSBIOS * Scheduling * Swi - Instance Settings =

Maodule Advanced

- Swis = Required Settings

swil

ENTIN | Add.. |  Handle swi0

Remove Function swilFxn

Interrupt priority 7
Initial trigger ]

w Thread Context

Argument( 0
Argumentl 1

T I

SY5/BIOS Swi 2 | cfg Seript

The cfg Script tab shows that the code to create this Swi would be as follows:

var Swi = xdc.useMdul e('ti.sysbios.knl.Sw");

/* Create a Sw Instance and nanipulate its instance paraneters. */
var sw Parans = new Swi . Par ans;

swi Par ans. ar g0 0;

swi Parans. argl = 1;

swi Paranms. priority = 7;

Program gl obal . swi 0 = Sw .create(' &w OFxn', sw Parans);

/* Create another Swi Instance using the default instance paraneters */

Program gl obal .swi1l = Sw .create(' &w 1Fxn');

SPRUEX3V—June 2020 SYS/BIOS Configuration and Building 29
Submit Documentation Feedback



http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SPRUEX3V
http://www.ti.com

Configuring SYS/BIOS Applications

i3 TEXAS

INSTRUMENTS

www.ti.com

23.1

Opening a Configuration File with XGCONF

To open XGCONF, follow these steps:

1. Make sure you are in the CCS Edit perspective of CCS.
If you are not in that perspective, click the perspective link

in the upper-right corner to switch back.

2. Double-click on the *.cfg configuration file in the Project
Explorer tree. While XGCONF is opening, the CCS
status bar shows that the configuration is being
processed and validated. (If your project does not yet contain a *.cfg file, see Section 2.2.)

3. When XGCONF opens, you see the Welcome sheet for SYS/BIOS. This sheet provides links to
SYS/BIOS documentation resources.

= >

B | B2 CCS Edit | *%; CCS Debug

4. Click the System Overview link to see a handy overview of the main modules you can use in
SYS/BIOS applications (see page 35).

* TI-RTOS * Products * SYSBIOS » BIOS - System Overview

= & @

Tirmer

M ailbox

Cache

HeapMultiBuf

Welcome Runtime Error Handling Device Support  Advanced
; ldle Clock
BIOS :
) : Task Swi
; &
Startup ... Synchronizaton
| i
; P Semaphore Event
; Startup P &
Diagnostics =~ Memory Mangement
éfrrnrHandlmg , Memory
- N o
E CPU Load N S
i e : I HeapMem HeapBuf
I, P
Note:

If the configuration is shown in a text editor instead of XGCONF, right-click on the *.cfg
file and choose Open With > XGCONF.
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2.3.2

Performing Tasks with XGCONF

The following list shows the configuration tasks you can perform with XGCONF and provides links to
explain how:

® Make more modules available. See page 34.

® Find a module. See page 33 and page 34.

® Add a module to the configuration. See page 33.

® Delete a module from the configuration. See page 34.

® Add an instance to the configuration. See page 34.

® Delete an instance from the configuration. See page 34.
® Change property values for a module. See page 35.

® Change property values for an instance. See page 35.

® Get help about a module. You can right-click in most places in XGCONF for and choose Help to get
information about a specific module or property. See page 34 and page 35.

® Configuring the memory map and section placement. The configuration file allows you to specify
which sections and heaps are used by various SYS/BIOS modules, but not their placement on the
target. Memory mapping and section placement is described in Chapter 7.

® Save the configuration or revert to the last saved file. See page 31.

® Fix errors in the configuration. See page 39.

You can open multiple configuration files at the same time. However, using XGCONF is resource
intensive and opening more than one file may slow down your system.

2.3.3  Saving the Configuration
If you have modified the configuration, you can press Ctrl+S to save the file. Or, choose File > Save from
the CCS menu bar.
In the cfg Script tab of a configuration, you can right-click and choose to Revert File to reload the last
saved configuration file or Save to save the current configuration to a file.
See Section 2.3.9 for information about the validation checks performed when you save a configuration
with XGCONF.
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2.3.4 About the XG

CONF views

The XGCONF tool is made up of several panes that are used together:

™\

=% Available Products 532

type filter text
4 333 TI-RTOS
@ TIRTOS
> §3y Drivers
. Menitors
a @ Products
4 i3 SYSBIOS
@ slos
y § System
. @4 Diagnostics
4 3 Scheduling
@ Task
B Swi
M Hyi
69 Idie
& Clock
ﬁﬁ Timer
> %% Synchronization

> 4% 10

» 4 Memory Management
> B Realtime Analysis

> 3 UIA

> 33 XDCtools

» &% Other Products

> iFf Target Specific Supportl]

3

e

2

~y

il

Instance Advanced

of a Swi (software interrupt) thread.

~ Time Base

() Application code calls Clock_tick()
() The Clock module is disabled

"The Clock module is disabled”,

~ Timer Control

Tick period (us) 1000

_/

' » TI-RTOS * Products * SYSBIOS ' Scheduling * Clock - Module Settin

The Clock module allows you to define one or more periodic functions that are run in the context

Add the Clock support module to my configuration

@ Internally configure a Timer to periodically call Clock_tick()

When the Clock Manager is enabled, the Time Base setting will follow the user's configuration.
‘When the Clock Manager is disabled, the Time Base setting will be internally forced to

See the SY5/BIOS 'Enable Clock Manager' setting under Threading Options'.

[ E NN NN NNNNNN]

5= outline 52 (&) & vﬁ |

type filter text

BIOS
Clock
Defaults
Diags
Error
Hwi
Main
Memory
Program
SysMin
System
Text

_/

Timer Id
\ Tick mode Tirmner will interrupt every period ‘ \
SYS/BIOS KDC/SysMin Clock 2 cfg Script

1. Available Products view lets you add modules to your configuration. By default, this view appears
in the lower-left corner of the window. See Section 2.3.5.

2. Outline view shows modules used in your current configuration and lets you choose the module to
display in the Properties view. By default, this view appears on the right side of the window. Two
display modes are provided: a user configuration list and a configuration results tree. See Section

2.3.6.

3. Property view shows the property settings of the selected module or instance and lets you make
changes. You can also use the cfg Script tab in the Property view to modify the script directly. See

Section 2.3.7

See Section 2.3.8.

Problems view appears if errors and warnings are detected in the configuration during validation.
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2.3.5

Using the Available Products View

The Available Products view lists the packages and
modules available for use in your configuration. It lists both
modules you are already using and modules you can add to
your configuration. The list is organized first by the software
component and then using functional categories.

Modules you can configure are listed in this tree. Modules
that do not apply to your target or are only used internally are
hidden in this tree.

Finding Modules

To find a particular module, expand the tree to see modules.
To find the SYS/BIOS modules, expand the TI-RTOS item
and then the Products item.

If you don’t know where a module is located or several
modules have similar names, type text in the "type filter text"
box. For example, you can type "gate" to find all the Gate
implementations in XDCtools, SYS/BIOS, and any other
repositories. You can use * and ? as wildcard characters.

If you want to look for a module using its full path within the
repository, right-click and choose Show Repositories. After
the category-based tree, you will see an All Repositories
node. You can expand this node to find particular modules.
For example, the full path to the SYS/BIOS Task module is
ti.sysbios.knl. Task.

Note that if you turn on Show Repositories, all modules are
listed. This includes modules that do not apply to your target
family and some modules (often shown as red balls) that you
cannot add to the configuration.

Adding Modules and Instances to the Configuration

To start using a module, right-click and choose Use
<module>. For example, choosing Use Swi adds the
ability to create and configure software interrupts to your
application. You can also drag modules from the Available
Products view to the Outline view to add them to the
configuration.

When you select a module in the Available Products view,
you see the properties you can set for that module in the
Property view (whether you are using it yet or not). When
you add use of a module to the configuration, that module
is shown in the Outline view.

You can get help on a particular module by right-clicking

=% Available Products 53 = OB

type filter et

4 3 TI-RTOS
& TIRTOS
. 3% Drivers
- Manitors
4 @ Products
4 3 SVSBIOS
& pios
- @ Systermn
. #% Diagnostics
a ¥ Scheduling
@ Task
B Swi
M Hi
(9 Idie
% Clock
ﬁj Tirner
. ™ Sunchronization
4 /0
. 3 Target Specific Support
. 4 Memory Management
- [ Realtime Analysis
23 UIA
- 333 XDCtools
. T=% Other Products

a % Scheduling

@ Tas

B Swi
M Hw Use Swi
('n Idiy Help
o8 Cle
ﬁj Tin Refresh View
' '}, Synchi Add/Change Products...
; .."U
% {]- et Check Path...
= arg
. o Memao Show Repositories

on the module name and choosing Help from the pop-up menu.

Adding a module to the configuration causes an xdc.useModule() statement to be added to the

configuration script.

SPRUEX3V—June 2020
Submit Documentation Feedback

SYS/BIOS Configuration and Building 33


http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SPRUEX3V
http://www.ti.com

13 TEXAS
INSTRUMENTS

Configuring SYS/BIOS Applications www.ti.com

Managing the Available Products List

When you open a configuration file with XGCONF, the package repositories that your application is set
to use in the Properties dialog are scanned for modules and the results are listed here.

You can add or remove products by right-clicking and choosing Add/Change Products. (This opens the
dialog you see by choosing Project > Properties from the CCS menus, then choosing the CCS General
category and the RTSC tab.) Check boxes next to versions of products you want to be able to use. If a
product isn’t listed, click the Add button to browse for a package repository in the file system. When you
click OK, the Available Products list is refreshed.

If TI-RTOS is selected, all the components included with TI-RTOS—including SYS/BIOS—will be
available for use.

You can open the Package Repository Path Browser by right-clicking and choosing Check Path. This
tool lists all the repositories and packages on the package path, shows the effects of adding repositories
or changing the order of locations in the path, and sorts the packages by various fields.

If there is a problem with the display or you have changed something in the file system that should affect
the modules shown, you can right-click and choose Refresh View.

2.3.6  Using the Outline View
The Outline view shows modules and instances that are available for configuration in your *.cfg file. You
can view the Outline in two ways:
® Show User Configuration. Select the | i= | icon. This is the easier-to-use view. This view mode
shows a flat list of only those modules directly referenced in the *.cfg file and instances created in the
*.cfg file. You can use this view to add instances of modules and delete the use of a module use from
the configuration.
® Show Configuration Results. Select the - | icon. This is the more advanced view. This mode
shows a tree view of all modules and instances that are used both implicitly (behind the scenes) and
explicitly (because they are referenced directly in the *.cfg file). You can edit any module that does
not have the "locked" icon. You can "unlock" some locked modules by choosing to add them to your
configuration. Instances that are shown as "locked" are used internally, and you should not attempt
to modify them.
As in the Available Products view, you can type filter text at the top of the Outline view to find modules
and instances by name.
To create an instance, right-click on a module and choose 4[® Semaphore
New <module>. For example, New Semaphore. Notice o P
that not all modules let you create instance objects. TYEE e
_ _ _ ® Swi Stop Using Semaphore
If you want to delete an instance from the configuration, @ SysMin
right-click on that instance in the Outline view, and select @ System Help
Delete <name> from the menu. @ Task
When you select a module or instance in the Outline view, you see the properties you can set for that
module in the Property view.
You can get help on a particular module by right-clicking on the module name and choosing Help from
the pop-up menu. Help on SYS/BIOS and XDCtools configuration is in the blue-gray (Configuration
settings) section of the online documentation. For each module, the configuration help follows the blue
sections that document that module’s C APIs.
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2.3.7

Some modules have a red ball next to them, while others have a blue ball. The & blue ball indicates
that this is a target module, which provides code or data that can be referenced at runtime on the
embedded target. The ® red ball indicates that this is a meta-only module, which exists in the
configuration but does not directly exist on the target.

To stop using a module in the configuration, right-click on that module in the Outline view, and select Stop
Using <module> from the menu. Deleting a module from the configuration removes the corresponding
xdc.useModule() statement and any instances of the module from the configuration script. If deleting the
module would result in an invalid script, an error message is displayed and the module is not deleted.
This can happen if a different module or instance refers to it in the script, for example in an assignment
to a proxy or a configuration parameter.

Using the Property View

If you select a module or instance in the Outline view or Available Products view, the Property view shows
properties for the selected item. There are several ways to view the properties.

¢ System Overview. This sheet provides a block diagram overview of the modules in TI-RTOS or
SYS/BIOS. See page 35.

® Module, Instance, or Basic. This layout organizes the properties visually. See page 37.

¢ Advanced. This layout provides a tabular list of property names and lets you set values in the table.
See page 38.

¢ cfg Script. The cfg script editor lets you edit the configuration script using a text editor. See page 38.

All the property sheets you have viewed are accessible from the tabs at the bottom of the Property view.
S¥5/BIOS | Clock hwi3 test leggerd Swi eventi =

You can use the <~ < arrow buttons in the upper-right of the Property view to move through

sheets you have already viewed. The Home icon returns you to the BIOS module System Overview.

For numeric fields, you can right-click on a field and choose Set Radix to choose whether to display this
field as a decimal or hex value.

Point to a field with your mouse for brief information about a property. Right-click on a field and choose
Help to jump directly to the documentation for that property. Click the () Help icon to get documentation
for the current module. Help on SYS/BIOS and XDCtools configuration is in the blue-gray section of the
online documentation. For each module, the configuration help follows the blue sections that document
that module’s C APls.

System Overview Block Diagram

The System Overview shows all of the core modules in SYS/BIOS as blocks. A green checkmark shows
the modules that are currently used by your configuration. You can add other modules in the diagram to
your configuration by right-clicking on the block and choosing Use. You can configure any module by
clicking on it.
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To return to the System Overview from some other property sheet, select the BIOS module in the Outline
View and click the System Overview button.

» TI-RTOS * Products * SYSBIOS * BIOS - System Overview o $ @
Welcome F‘untlm& Error Handling Device Support  Advanced

Idle Clock Timer

BIOS § !

& Task Swi Hui i

; @ i

Startup________ Synchronization

)

Semaphore Event Mailbox l

Diagnostics =~ Memory Mangement e
E Error Handling P HE Cache I
- n 2 |
: CPU Load gy i
I GTimestarnp : I HeapMem HeapBuf HeapMultiBuf :

You can add object instances to the configuration by right-clicking on a module and choosing the New
command.
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Module and Instance Property Sheets

The Module and Instance property sheets organize properties into categories and provides brief
descriptions of some properties. Checkboxes, selection fields, and text fields are provided depending on
the type of values a property can have.

& “static.cfg &3 = 0O

SYS/BIOS * Scheduling * Clock - Module Settings <~ & (B

Instance Advanced

The Clack module allows you to define one or more pericdic functions that are run in the
context of a Swi (software interrupt) thread.

[V] Add the Clock support module to my configuration

+ Time Base + Scheduling

Swi priority 15
i@ Usze Timer to automatically call Clock_tick()

The priority ab t th
) Application explicithy calls Clock_tick() iR

pricrity for all Cleck functions

) Clock tick() is never called independent of their period.
Higher numbers have higher
= Timer Control priority,

Tick pericd (us] 5000

Timer Id laNY - |

Click the Module button to see and modify global properties for the module. In the Module property sheet
for optional modules, you can uncheck the Add <module> to my configuration box to stop using a
module. If you aren’t using a module, you can add it to your configuration by checking the box.

Click the Instance button to see properties for instances. A list on the left side of the page shows the
instances that have been created and lets you add or remove instances.

Some advanced properties aren’t shown in the Module and Instance sheets. For these, see the
Advanced sheet (page 38).

As you change properties, they are applied to the configuration and validated. However, they are not
saved until you save the configuration file.

You can fold up or reopen portions of the property sheet by clicking the arrow next to a section heading.
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Advanced Properties Sheet
The Advanced layout provides a tabular list of property names and lets you set values in the table.
| & *static.cfg 3 ]

SYS/BIOS * Scheduling * Clock - All Options CREE O]

Module Instance

Basic | xdc.runtime |

Mame Value Sumrmary
tickSource TickSource_TIMER Source of clock ticks
tickMode TickMode_PERIODIC Tirmer tick mode
timerld -1 Timer Id uszed to create a Timer instance
swiPriority 15 The pricrity of Swi used by Clock to proces...
tickPericd 5000 Tick pericd specified in microseconds

SYS/BIOS | Clock &3 | cfg Script

To modify the value of a property, click on a row in the Value column and type or select a new value.

When you type a value for a property, XGCONF checks to make sure the type of the value matches the
type expected for the property. This is separate from the more extensive validation checks that are
performed when you save a configuration.

For many modules, the Advanced layout has both a Basic tab and an xdc.runtime tab. The Basic tab
shows the same properties as the Basic view, but in tabular form. The xdc.runtime tab shows
<module>.common$ properties inherited by the module. For example, these include properties related
to the memory used by the module and any instances, the diagnostics settings for the module, and the
Gate object used by this module if any. In addition, events, asserts, and errors that can occur for this
module are listed. See the online documentation for xdc.runtime.Types for more about the common$
properties.

Point to a field with your mouse for brief information about a property. Right-click on a field and choose
Help to jump directly to the documentation for that property. Click the (Z) Help icon to get documentation
for the current module.

Cfg Script Editor

The cfg script editor lets you edit the configuration script using a text editor by choosing the cfg Script
tab. Some advanced scripting features are available only by editing the script directly. For more
information see links from the http://rtsc.eclipseprojects.io/docs-tip/RTSC_Scripting_Primer wiki page.

You can use Ctrl+S to save any changes you make. You can right-click on the file and choose Undo
Typing to undo the most recent graphical editing operation, or Revert File to return to the most recently
saved version of this file. When you save the file, it is validated and the other panes are refreshed to
reflect your changes.

When you select a module or instance in the Outline view, the cfg Script tab highlights all the lines of the
configuration file that are related to that module or instance.
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2.3.8

Using the Problems View

The Problems view lists all errors and warnings detected during a build or validation of the configuration
script. This view is automatically displayed whenever new errors or warnings are detected.

{5 Problems &7
1 errer, 0 warnings, 0 infos
Description Resource  Path

a4 T Errors (1 item)
€3 Task.numPriorities (38) can't be greater than the number of bits in an integer (32) mutex.cfg  Task_M

The Outline view shows an £#® error icon next to any modules or instances for which problems were
detected. If you select such a module, the Properties view shows a red X icon next to the properties that
are incorrectly set.

If you double-click on an item in the Problems view while the cfg Script tab is displayed, the cfg Script
tab highlights the statement that caused the error or warning, and an error icon is shown in the left margin.
Position indicators for any problems also appear to the right of the scrollbar.

355vystem. SupportProxy = SysMin;
@E-E ask.mumPriorities = 38;

-

Depending on the type of problem, the validation may only report the first item found in the configuration.
For example, a syntax error such as an unknown variable in the script may prevent later problems, such
as invalid values being assigned to a property, from being reported. Such problems can be detected after
you fix the syntax error and re-validate the configuration.

If there is not enough detail available to identify a specific configuration parameter, no problem icon will
be shown in the Properties tab. A problem icon will still be shown on the module or instance in the Outline
view.

You can sort the problem list by clicking on the headings. You can filter the problem list to display fewer
items by clicking the 5= Filter icon to open the Filters dialog.

2.3.9 Finding and Fixing Errors
A configuration is validated if you perform any of the following actions:
® Add a module to be used in the configuration
® Delete a module from use by the configuration
® Add ainstance to the configuration
® Delete an instance from the configuration
® Save the configuration
You can force the configuration to be validated by saving the configuration or by clicking the . Refresh
icon.
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2.3.10

Validation means that semantic checks are performed to make sure that, for example, objects that are
referenced actually exist. These checks also make sure that values are within the valid ranges for a
property. Some datatype checking is performed when you set a property in the Properties tab.

If you are editing the configuration code directly in the ¢fg Script tab, the configuration is validated only
if you save the configuration.

While a configuration is being validated (this takes a few seconds), you see the a progress icon in the
lower-right corner of the window.

Yalidating mutex.cfg

After the configuration has been validated, any errors that were detected in the configuration are shown
in the Problems view. For example, if you delete the statement that creates an instance that is referenced
by another configuration parameter, you will see an error.

See Section 2.3.8 for more about finding and fixing errors.

Accessing the Global Namespace

Many of the configuration examples in this document define variables in the Pr ogr am gl obal
namespace. For example:

Program gl obal . nyTimer = Timer.create(1l, "&mylsr", timerParans);

The Program module is the root of the configuration object model created by XDCtools; the Program
module is implicitly used by configuration scripts; you do not need to add a useModule statement to make
it available.

Variables defined in Program.global become global symbols that can be used to directly reference
objects in C code. These objects are declared in a generated header file. In order to use these variables,
your C code needs to include the generated header file as follows:

#i ncl ude <xdc/ cfg/ gl obal . h>
C code can then access these global symbols directly. For example:
Ti mer _reconfig(nyTimer, tickFxn, &timerParans, &eb);

If you do not want to #include the generated global.h file, you can declare external handles explicitly. For
example, adding the following declaration to your C code would allow you to use the statically configured
myTimer object in the previous example:

#i ncl ude <ti/sysbi os/hal/Tiner. h>

extern Tiner_Handl e nyTi ner;

For more about the Program module, see http://rtsc.eclipseprojects.io/cdoc-tip/xdc/cfg/Program.html.
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2.4

24.1

Building SYS/BIOS Applications

When you build an application project, the associated configuration file is rebuilt if the configuration has
been changed. The folders listed in the "Includes" list of the CCS project tree (except for the compiler-
related folder) are folders that are on the package path.

To build a project, follow these steps:
1. Choose Project > Build Project.
2. Examine the log in the Console view to see if errors occurred.

3. After you build the project, look at the C/C++ Projects view. You can expand the Debug folder to see
the files that were generated by the build process.

For help with build errors, see the wiki page at http://rtsc.eclipseprojects.io/docs-tip/Trouble_Shooting.

Understanding the Build Flow

The build flow for SYS/BIOS applications begins with an extra step to process the configuration file (*.cfg)
in the project. The configuration file is processed by XDCtools. If you look at the messages printed during
the build, you will see a command line that runs the "xs" executable in the XDCtools component with the
"xdc.tools.configuro” tool specified. For example:

"I nvoki ng: XDCt ool s'

"<xdc_install _dir>/xs" --xdcpat h="<bi os_i nstall _dir>/packages;" xdc.tools.configuro
-0 configPkg -t ti.targets.armelf.M3 -p ti.platformnms.concertoM: F28MB5H52C1
-r release -c "C/ccs/ccsv6e/tool s/ compiler/tnms470" "../exanple.cfg"

In CCS, you can control the command-line options used with XDCtools by choosing Project > Properties
from the menus and selecting the Build > XDCtools category.

<+ Properties for mcu_fatfs_w_apis_ C=mlEEs X

type filter text XDCtools P v -
+ Resource
General

4 Build Configuration: |Debug [ Active ] '] ’Manage Configurations...

» TMS4T0 Compiler

. TMS4T0 Linker
4| XDCtoals Command: "SIXDC_CG_ROOTus"

Package Repositories | Command-line pattern:  ${command} §{flags} ${inputs}

Basic Options g £l .
Advanced Options vrnmary of Tlags se=

--xdepath="C:/ti/mcusdk_1_00_00_36_eng/packages;C:/Program Files (x86)/Texas
Instruments/bios_6_33_00_19/packages; C:/ti/mcusdk_1_00_00_35_eng/products/uia_1_00_04_30_eng/
packages;” xdc.tools.configuro -o configPkg -t titargets.arm.elf. M3 -p

ti.platforms.concertoM3:F2BM35H52C1 -r release -¢ "C/fcos/cosvh/tools/compiler/tms470"

.,

=
(?)  Show advanced settings [ OK ] [ Cancel

S

Target settings for processing your individual project are in the RTSC tab of the CCS General category.
(RTSC is the name for the Eclipse specification implemented by XDCtools.)
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24.2

2.4.3

When XDCtools processes your *.cfg file, code is placed in the <project_dir>/<configuration>/configPkg
directory (where <configuration> is Debug or Release depending on your active CCS configuration. This
code is compiled so that it can be linked with your final application. In addition, a compiler.opt file is
created for use during program compilation, and a linker.cmd file is created for use in linking the
application. You should not modify the files in the <project_dir>/<configuration>/configPkg directory after
they are generated, since they will be overwritten the next time you build.

For command-line details about xdc.tools.configuro, see the RTSC-pedia reference topic. Configuro can
also be used to build the configuration file with other build systems. For more information, see the wiki
page at http://rtsc.eclipseprojects.io/docs-tip/Consuming_Configurable_Content.

Rules for Working with CCS Project Properties

After you have created a CCS project that contains a configuration file, you can change the properties of
the project in CCS by right-clicking the project name and choosing Properties.

In the CCS General category of the Properties dialog, the General tab applies to compiler settings, and
the RTSC tab applies to the "configuro” utility used to process the .cfg file.

If there is any platform-specific configuration in your .cfg file, you must change those settings in addition
to any platform-related changes you make to the CCS General > RTSC settings.

If your configuration file is stored in a separate project from the project that contains your source code
files, you should be careful about changing the CCS General settings for a configuration-only project. The
build settings for the configuration project must match or be compatible with those of all application
projects that reference the configuration project. So, if you change the build settings for a configuration
project, you should also change the build settings for the application projects that use that configuration.

Building an Application with GCC

The instructions in this section can be used to build SYS/BIOS applications on Windows or Linux. If you
are using a Windows machine, you can use the regular DOS command shell provided with Windows.
However, you may want to install a Unix-like shell, such as Cygwin.

For Windows users, the XDCtools top-level installation directory contains gmake. exe, which is used in
the commands that follow to run the Makefile. The gmake utility is a Windows version of the standard
GNU "make" utility provided with Linux.

If you are using Linux, change the "gmake" command to "make" in the commands that follow.

Requirements

® You must have SYS/BIOS and XDCtools installed on the system where you intend to build the
application.

®  You must have the GCC compiler system installed on the system where you intend to build the
application. For example, you can use the Linaro Baremetal GNU Toolchain as a compiler for Cortex-
A8/A9/A15 and Cortex-M3/M4/M4F targets (that is, targets that support GNU). See the
documentation links on the web page at the link above for installation instructions.

® Your application must have a configuration file (*.cfg) that configures the application’s use of
XDCtools and SYS/BIOS.
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Limitations
Note: XDCtools provides linker scripts for most Stellaris and Tiva devices. If you are building
for a device that is not yet supported, you will need to modify one of these script files.
Description

The command line tools can be invoked directly or (preferably) the build can be managed with makefiles.
When the SYS/BIOS configuration file is built, the output will include:

Procedure

conpi | er. opt, which contains a set of options for the C compiler to use when compiling user
applications. The file contains is a set of #include options and pre-processor #defines. The
compiler.opt file can be provided to GCC via the @option.

I'i nker. cnd, which contains a set of linker options for use when linking applications. The file contains
a list of libraries and object files produced from the configuration. It also specifies memory placement
for memory used by SYS/BIOS. This file should be passed to the linker using the - W, - T, cf g- out -
dir/linker.cnd option.

Follow these steps to build a SYS/BIOS application with the GCC compiler:

1.

Download the sample package from the page for your device family linked to by the TI-RTOS Kernel
Device Addendum (Bl OS_I NSTALL_DI R/ docs/ Devi ce_Addendum ht nl ). Uncompress the sample
package to the location where you will build your applications. The file contains:

— hello.c,clock.c,andtask. c: Three simple C code files are included—a simple “hello world”
application, one that uses the SYS/BIOS Clock module, and one that uses the Task and
Semaphore modules.

— app. cf g: A simple shared configuration file for these applications.
— tmicl123gh6pm | ds: A linker script for a Tiva TM4C123GH6PM device.

— Makefi | e: A makefile that can be used to build the applications from the command line.

2. Open the Makef i | e with a text editor. Edit the first three lines of the sample Makef i | e to specify the
locations on your system for MATOOLS (the GCC compiler location), SYSBIOS, and XDCTOOLS.
For example:

MATOOLS ?= / hone/ nyuser nane/ | i nar o/ gcc- ar m none- eabi -4_7-2013qg3
SYSBI OS ?= / home/ nyuser nane/ bi os_6_## ## ##
XDCTOOLS ?= / hone/ myuser nane/ xdct ool s_3_##_##_##

3. If you are building for a device other than a Tiva TM4C123GHG6PM, first check the
XDCTOOLS/ packages/ti/platforms/tivalinclude_gnu directory to see if a linker script file is
provided for your device.

4. If no linker script file is provided for your device, make a copy of the closest provided file and edit the
“MEMORY” region specifications to make them correspond to the memory map for your device. You
can specify your new linker script file as the LINKERCMD file in the Makefi | e.

5. If you are using a linker script file other than t mic123gh6pm | ds, edit the Makefi | e to change the
LINKERCMD setting.
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6. If you are using Windows and the gmake ultility provided in the top-level directory of the XDCtools
installation, you should add the <xdc_i nst al | _di r > to your PATH environment variable so that the
gmake executable can be found.
7. Build the three sample applications by running the following command. (If you are running the build
on Linux, change all "gmake" commands to "make".)
| gmake |
8. You can clean the build by running the following command:
| gmake cl ean |
9. Once built, applications can be loaded and debugged with CCS. Within CCS, you can use Tools >

Runtime Object View to browse SYS/BIOS kernel object states and various other tools for real-time
analysis. Alternatively, you can use GDB or another debugger for basic debugging, but the ROV is
not available outside of CCS.

For more information, such as the compiler and linker options needed by SYS/BIOS for the Cortex-A and
Cortex-M device families, see the TI-RTOS Kernel Device Addendum

(Bl OS_I NSTALL_DI R/ docs/ Devi ce_Addendum ht nl ). Additional information about building with various
compilers may be found on the RTSC-pedia wiki.

2.4.4  Running and Debugging an Application in CCS

If you haven't already created a default target configuration, follow these steps:

1. Choose File > New > Target Configuration File.

2. Type a filename for the target configuration, which will be stored as part of the CCS project. For
example, you might type TC16482sim.ccxml if that is the target you want to use. Then, click Finish.

3. In the Connection field for your target configuration, choose the type of connection you have to the
target. Then type part of the target name in the Device filter field. For example, you might choose the
"Tl Simulator" connection and filter by "64xp" to find a C64x+ simulator.

4. Choose File > Save or click the Save icon to save your target configuration.
You can right-click on a target configuration and choose Set as Default Target to set which target
configuration is used for debugging.

To debug an application, follow these steps:

1. Choose Target > Debug Active Project or click the Debug icon. This loads the program and
switches you to the "Debug" perspective.
You can set breakpoints in your code if desired. Press F8 to run.

3. Use various tools provided with XDCtools and SYS/BIOS to debug the application. See Section 9.4
for a more detailed comparison.
— Runtime Object View (ROV). See the Runtime Object View (ROV) User’s Guide in Tl Resource

Explorer.
— System Analyzer. See the System Analyzer User’s Guide (SPRUH43).
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2.4.5

Compiler and Linker Optimization

You can optimize your application for better performance and code size or to give you more debugging
information by selecting different ways of compiling and linking your application. For example, you can
do this by linking with versions of the SYS/BIOS libraries that were compiled differently.

The choices you can make related to compiler and linker optimization are located in the following places:

Build-Profile. You see this field when you are creating a new CCS project or modifying the CCS
General settings. We recommend that you use the "release" setting. The "release" option is preferred
even when you are creating and debugging an application; the "debug" option is mainly intended for
internal use by Texas Instruments. The "release" option results in a somewhat smaller executable
that can still be debugged. This build profile primarily affects how Codec Engine and some device
drivers are built.

Note: The "whole_program" and "whole_program_debug" options for the Build-Profile have
been deprecated, and are no longer supported. The option that provides the most
similar result is to set the BIOS.libType configuration parameter to
BIOS.LibType_ Custom.

Configuration. The drop-down field at the top of the Properties dialog allows you to choose between
and customize multiple build configurations. Each configuration can have the compiler and linker
settings you choose. Debug and Release are the default configurations available.

BIOS.libType configuration parameter. You can set this parameter in XGCONF or by editing the
*.cfg file in your project. This parameter lets you select one of several custom versions of the
SYS/BIOS libraries to be built based on the needs of your application. See the table and discussion
that follow for more information.

The options for the BIOS.libType configuration parameter are as follows:

BIOS.libType Logging/Asserts Code Size Runtime Performance

Instrumented On Good Good
(BIOS.LibType_Instrumented)

Non-Instrumented Off Better Better
(BIOS.LibType_NonlInstrumented)

Custom (Optimized) As configured Best Best
(BIOS.LibType_Custom)

Debug As configured Largest No optimization
(BIOS.LibType_Debug)

For all libType options, the executable that is created contains only the modules and APlIs that your
application needs to access. If you have not used a particular module in your *.cfg file or your C code
(and it is not required internally by a SYS/BIOS module that is used), that module is not linked with your
application. Individual API functions that are not needed (either directly or indirectly) are also excluded
during the linking phase of the build.

Instrumented. (default) This option results in a SYS/BIOS library being built with all Asserts and
Logs enabled. Your configuration file can additionally enable or disable various Diags and logging-
related settings. However, note that the checks to see if Diags are enabled before outputting a Log
event are always performed, which has an impact on performance even if you use the ALWAYS_ON
or ALWAYS_OFF setting. The resulting code size when using this option may be too large to fit on
some targets, such as C28x and MSP430.
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® Non-Instrumented. This option results in a SYS/BIOS library being built with all Asserts and Logs
disabled. No Assert or Diag settings are checked, and logging information is not available at runtime.
The checking for Asserts and Diags is compiled out of the libraries, so runtime performance and code
size are optimized. Checking of Error_Blocks and handling errors in ways other than logging an event
are still supported.

® Custom (Optimized). This option results in a SYS/BIOS library being built as configured by the user.
This option is optimized to provide the best runtime performance and code size given the needs of
your application. Instrumentation is available to whatever extent your application configures it. This
build preserves enough debug information to make it still possible to step through the optimized code
in CCS and locate global variables.

® Debug (Non-Optimized). This option results in a SYS/BIOS library being built as configured by the
user but with no optimizations enabled and full debug information embedded in the library. The
resulting application is fully debuggable; you can step into the code performed by SYS/BIOS APlIs.
Since no optimization is performed, the code size is large and the runtime performance is slower than
with the custom libType.

All libType options except the Debug option use aggressive program optimizations that remove many
initialized constants and small code fragments (often "glue" code) from the final executable image. Such
classic optimizations as constant folding and function inlining are used, including across module
boundaries.

The first time you build a project, the build will be longer due to the SYS/BIOS library build process. The
libraries are stored in the "src" directory of your project. Subsequent builds may be faster; libraries do not
need to be rebuilt unless you change one of the few configuration parameters that affect the build settings
or use an additional module that wasn'’t already used in the previous configuration.

The following example statements set the BIOS.libType configuration parameter:

var BI OGS = xdc. useMdul e('ti.syshios.BICS);
Bl CS. | i bType = BI CS. Li bType_Cust om

If you use the BIOS.LibType Custom or BIOS.LibType Debug option for the BIOS.libType, you can also
set the BIOS.customCCOpts parameter to customize the C compiler command-line options used when
compiling the SYS/BIOS libraries. If you want to change this parameter, it is important to first examine
and understand the default command-line options used to compile the SYS/BIOS libraries for your target.
You can see the default in XGCONF or by placing the following statement in your configuration script and
building the project:

| print("custonCCOpts =", BICS. custonCCOpts) ;

You must be careful not to cause problems for the SYS/BIOS compilation when you modify the
BIOS.customCCOpts parameter. For example, the --program_level_compile option is required.

(Some --define and --include_path options are used on the compiler command line but are not listed in
the customCCOpts definition; these also cannot be removed.)

For example, to create a debuggable custom library, you can remove the -03 option from the
BIOS.customCCOpts definition by specifying it with the following string for a C64x+ target:

Bl CS. cust onCCOpts = "-nv64p --abi=eabi -q -m 10 -no -pdr -pden -pds=238 - pds=880
-pds1110 --program|evel _conpile -g";

For more about configuring BIOS.libType and BIOS.customCCOpts, see the Documentation Overview
(Bl OS_I NSTALL_DI R/ docs/ Docunent ati on_Over vi ew. ht nl ). See Appendix A for information about
how to rebuild SYS/BIOS manually.
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3.1 SYS/BIOS Startup Sequence

The SYS/BIOS startup sequence is logically divided into two phases—those operations that occur prior

to the application's "main()" function being called and those operations that are performed after the

application's "main()" function is invoked. Control points are provided at various places in each of the two
startup sequences for user startup functions to be inserted.

The "before main()" startup sequence is governed completely by the XDCtools runtime package. For

more information about the boot sequence prior to main, refer to the "XDCtools Boot Sequence and

Control Points" wiki page. The XDCtools runtime startup sequence is as follows:

1. Immediately after CPU reset, perform target/device-specific CPU initialization (beginning at ¢_int00).
See the "Program Loading and Running" chapter in the Assembly Language Tools User’s Guide for
your target family for details on this step and the cinit() step.

2. Prior to cinit(), run the table of "reset functions" (the xdc.runtime.Reset module provides this hook).
The functions specified in the Reset.fxns[] array are called. These reset functions are called only on
platforms where a reset is performed before running a program.

3. Run cinit() to initialize C runtime environment.

4. Run the user-supplied "first functions" (the xdc.runtime.Startup module provides this hook).

5. Run all the module initialization functions.

6. Run the user-supplied "last functions" (the xdc.runtime.Startup module provides this hook).

7. Run pinit().

8. Run main().

The "after main()" startup sequence is governed by SYS/BIOS and is initiated by an explicit call to the

BIOS_start() function at the end of the application's main() function. The SYS/BIOS startup sequence that

run when BIOS_start() is called is as follows:

1. Startup Functions. Run the user-supplied "startup functions" (see BIOS.startupFxns). If the system
supports Timers, all statically created timers are initialized at this point using their static configuration.
If a timer was configured to start "automatically," it is started here.

2. Enable Hardware Interrupts.

3. Enable Software Interrupts. If the system supports software interrupts (Swis) (see
BIOS.swiEnabled), then the SYS/BIOS startup sequence enables Swis at this point.

4. Task Startup. If the system supports Tasks (see BIOS.taskEnabled), then task scheduling begins
here. If there are no statically or dynamically created Tasks in the system, then execution proceeds
directly to the idle loop.
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The following configuration script excerpt installs a user-supplied startup function at every possible
control point in the startup sequence. Configuration scripts have a file extension ".cfg" and used to
configure modules and objects.

/* get handle to xdc Reset nodule */
Reset = xdc.useModul e(' xdc. runti nme. Reset');

/* install a "reset function" */
Reset . f xns[ Reset . f xns. | engt h++] = ' &myReset ' ;

/* get handle to xdc Startup nodule */
var Startup = xdc.useMdul e(’' xdc.runtine. Startup');

/* install a "first function" */
Startup.firstFxns[Startup.firstFxns.|ength++] = '&nyFirst';

/* install a "last function" */
Startup. |l ast Fxns[ Startup. | ast Fxns. | engt h++] = ' &mylLast';

/* get handle to BICS nodule */
var BI OGS = xdc. useMdul e('ti.syshios.BICS);

/* install a BIGS startup function */
Bl CS. addUser St art upFuncti on(' &vyBi osStartup');

3.2 Overview of Threading Modules

Many real-time applications must perform a number of seemingly unrelated functions at the same time,
often in response to external events such as the availability of data or the presence of a control signal.
Both the functions performed and when they are performed are important.

These functions are called threads. Different systems define threads either narrowly or broadly. Within
SYS/BIOS, the term is defined broadly to include any independent stream of instructions executed by the
processor. A thread is a single point of control that can activate a function call or an interrupt service
routine (ISR).

SYS/BIOS enables your applications to be structured as a collection of threads, each of which carries out
a modularized function. Multithreaded programs run on a single processor by allowing higher-priority
threads to preempt lower-priority threads and by allowing various types of interaction between threads,
including blocking, communication, and synchronization.

Real-time application programs organized in such a modular fashion—as opposed to a single,
centralized polling loop, for example—are easier to design, implement, and maintain.

SYS/BIOS provides support for several types of program threads with different priorities. Each thread
type has different execution and preemption characteristics. The thread types (from highest to lowest
priority) are:

® Hardware interrupts (Hwi), which includes Timer functions
® Software interrupts (Swi), which includes Clock functions
® Tasks (Task)

® Background thread (Idle)
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These thread types are described briefly in the following section and discussed in more detail in the rest
of this chapter.

Types of Threads

The four major types of threads in a SYS/BIOS program are:

Hardware interrupt (Hwi) threads. Hwi threads (also called Interrupt Service Routines or ISRs) are
the threads with the highest priority in a SYS/BIOS application. Hwi threads are used to perform time
critical tasks that are subject to hard deadlines. They are triggered in response to external
asynchronous events (interrupts) that occur in the real-time environment. Hwi threads always run to
completion but can be preempted temporarily by Hwi threads triggered by other interrupts, if enabled.
See Section 3.4, Hardware Interrupts, page 58, for details about hardware interrupts.

Software interrupt (Swi) threads. Patterned after hardware interrupts (Hwi), software interrupt
threads provide additional priority levels between Hwi threads and Task threads. Unlike Hwis, which
are triggered by hardware interrupts, Swis are triggered programmatically by calling certain Swi
module APls. Swis handle threads subject to time constraints that preclude them from being run as
tasks, but whose deadlines are not as severe as those of hardware ISRs. Like Hwi's, Swi's threads
always run to completion. Swis allow Hwis to defer less critical processing to a lower-priority thread,
minimizing the time the CPU spends inside an interrupt service routine, where other Hwis can be
disabled. Swis require only enough space to save the context for each Swi interrupt priority level,
while Tasks use a separate stack for each thread. See Section 3.5, Software Interrupts, page 66, for
details about Swis.

Task (Task) threads. Task threads have higher priority than the background (Idle) thread and lower
priority than software interrupts. Tasks differ from software interrupts in that they can wait (block)
during execution until necessary resources are available. Tasks require a separate stack for each
thread. SYS/BIOS provides a number of mechanisms that can be used for inter-task communication
and synchronization. These include Semaphores, Events, Message queues, and Mailboxes. See
Section 3.6, Tasks, page 82, for details about tasks.

Idle Loop (Idle) thread. Idle threads execute at the lowest priority in a SYS/BIOS application and
are executed one after another in a continuous loop (the Idle Loop). After main returns, a SYS/BIOS
application calls the startup routine for each SYS/BIOS module and then falls into the Idle Loop. Each
thread must wait for all others to finish executing before it is called again. The Idle Loop runs
continuously except when it is preempted by higher-priority threads. Only functions that do not have
hard deadlines should be executed in the Idle Loop. See Section 3.7, The Idle Loop, page 100, for
details about the background thread.

Another type of thread, a Clock thread, is run within the context of a Swi thread that is triggered by a Hwi
thread invoked by a repetitive timer peripheral interrupt. See Section 5.2 for details.

Note: SYS/BIOS also provides a subset of the POSIX thread (pthread) APIs. These include
pthread threads, mutexes, read-write locks, barriers, and condition variables. The
pthread APIs can simplify porting applications from a POSIX environment to
SYS/BIOS, as well as allowing code to be compiled to run in both a POSIX environment
and with SYS/BIOS. As the pthread APIs are built on top of the SYS/BIOS Task and
Semaphore modules, some POSIX APls can be called from SYS/BIOS Tasks.

For details about supported POSIX thread APIs, see the TI-POSIX User’s Guide in the
/ docs/ ti posi x/ Users_Gui de. ht i file in the TI-RTOS Kernel installation. For more,
see the official POSIX specification and the generic POSIX implementation.
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3.2.2 Choosing Which Types of Threads to Use

The type and priority level you choose for each thread in an application program has an impact on
whether the threads are scheduled on time and executed correctly. SYS/BIOS static configuration makes
it easy to change a thread from one type to another.

A program can use multiple types of threads. Here are some rules for deciding which type of object to
use for each thread to be performed by a program.

Swi or Task versus Hwi. Perform only critical processing within hardware interrupt service routines.
Hwis should be considered for processing hardware interrupts (IRQs) with deadlines down to the
5-microsecond range, especially when data may be overwritten if the deadline is not met. Swis or
Tasks should be considered for events with longer deadlines—around 100 microseconds or more.
Your Hwi functions should post Swis or tasks to perform lower-priority processing. Using lower-
priority threads minimizes the length of time interrupts are disabled (interrupt latency), allowing other
hardware interrupts to occur.

Swi versus Task. Use Swis if functions have relatively simple interdependencies and data sharing
requirements. Use tasks if the requirements are more complex. While higher-priority threads can
preempt lower priority threads, only tasks can wait for another event, such as resource availability.
Tasks also have more options than Swis when using shared data. All input needed by a Swi’s function
should be ready when the program posts the Swi. The Swi object’s trigger structure provides a way
to determine when resources are available. Swis are more memory-efficient because they all run
from a single stack.

Idle. Create Idle threads to perform noncritical housekeeping tasks when no other processing is
necessary. ldle threads typically have no hard deadlines. Instead, they run when the system has
unused processor time. Idle threads run sequentially at the same priority. You may use Idle threads
to reduce power needs when other processing is not being performed. In this case, you should not
depend upon housekeeping tasks to occur during power reduction times.

Clock. Use Clock functions when you want a function to run at a rate based on a multiple of the
interrupt rate of the peripheral that is driving the Clock tick. Clock functions can be configured to
execute either periodically or just once. These functions run as Swi functions.

Clock versus Swi. All Clock functions run at the same Swi priority, so one Clock function cannot
preempt another. However, Clock functions can post lower-priority Swi threads for lengthy processing.
This ensures that the Clock Swi can preempt those functions when the next system tick occurs and
when the Clock Swi is posted again.

Timer. Timer threads are run within the context of a Hwi thread. As such, they inherit the priority of
the corresponding Timer interrupt. They are invoked at the rate of the programmed Timer period.
Timer threads should do the absolute minimum necessary to complete the task required. If more
processing time is required, consider posting a Swi to do the work or posting a Semaphore for later
processing by a task so that CPU time is efficiently managed.
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3.2.3 A Comparison of Thread Characteristics
Table 3-1 provides a comparison of the thread types supported by SYS/BIOS.
Table 3-1. Comparison of Thread Characteristics
Characteristic Hwi Swi Task Idle
Priority Highest 2nd highest 2nd lowest Lowest
Number of priority family/device- Up to 32 (16 for Up to 32 (16 for 1
levels specific MSP430 and C28x). MSP430 and C28x).
Periodic functions run This includes 1 for the
at the priority of the Idle Loop.
Clock Swi.
Can yield and pend No, runs to No, runs to completion  Yes Should not pend.

Pending would
disable all regis-
tered Idle threads.

Ready, running

Program exit

main() exits and no
other thread is
currently running

Task stack used by
default (see Note 1)

--Not applicable--

--Not applicable--

Streams, lists, pipes,
global variables

Synchronize with --Not applicable-- Swi trigger Semaphores, events,  -Not applicable--
thread via mailboxes
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Characteristic Hwi Swi Task Idle
Function hooks Yes: register, Yes:register, create, Yes: register, create, No
create, begin, end, ready, begin, end, ready, switch, exit,
delete delete delete
Static creation Yes Yes Yes Yes
Dynamic creation Yes Yes Yes No
Dynamically change  See Note 2 Yes Yes No
priority
Implicit logging Interrupt event Post, begin, end Switch, yield, ready, None
exit
Implicit statistics None None None None

Notes: 1) If you disable the Task manager, Idle threads use the system stack.

2) Some devices allow hardware interrupt priorities to by modified.

3.24 Thread Priorities

Within SYS/BIOS, hardware interrupts have the highest priority. The priorities among the set of Hwi
objects are not maintained implicitly by SYS/BIOS. The Hwi priority only applies to the order in which
multiple interrupts that are ready on a given CPU cycle are serviced by the CPU. Hardware interrupts are
preempted by another interrupt unless interrupts are globally disabled or when specific interrupts are
individually disabled.

Figure 3-1. Thread Priorities

Tasks
up to 32 levels

A
Hardware :
Timer
Interrupts Functi
. unctions
(Hwi)
— Software
— Interrupts Clock
— (Swi) Functions
2 | —upto32levels
S| =
T =

Background thread
(Idle)

Swis have lower priority than Hwis. There are up to 32 priority levels available for Swis (16 by default)
The maximum number of priority levels is 16 for MSP430 and C28x. Swis can be preempted by a higher-priority
Swi or any Hwi. Swis cannot block.
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3.25

Tasks have lower priority than Swis. There are up to 32 task priority levels (16 by default). The maximum
number of priority levels is 16 for MSP430 and C28x. Tasks can be preempted by any higher-priority thread.
Tasks can block while waiting for resource availability and lower-priority threads.

For Swis and Tasks, higher numbers equal higher priorities. That is, zero is the lowest priority level within
the set of Swis and within the set of Tasks.

The background Idle Loop is the thread with the lowest priority of all. It runs in a loop when the CPU is

not busy running another thread. When tasks are enabled, the Idle Loop is implemented as the only task
running at priority 0. When tasks are disabled, the Idle Loop is fallen into after the application's "main()"
function is called.

Yielding and Preemption

The SYS/BIOS thread schedulers run the highest-priority (highest priority number) thread that is ready
to run except in the following cases:

® The thread thatis running disables some or all hardware interrupts temporarily with Hwi_disable() or
Hwi_disablelnterrupt(), preventing hardware ISRs from running.

® The thread that is running disables Swis temporarily with Swi_disable(). This prevents any higher-
priority Swi from preempting the current thread. It does not prevent Hwis from preempting the current
thread.

® The thread that is running disables task scheduling temporarily with Task_disable(). This prevents
any higher-priority task from preempting the current task. It does not prevent Hwis and Swis from
preempting the current task.

® If alower priority task shares a gating resource with a higher task and changes its state to pending,
the higher priority task may effectively have its priority set to that of the lower priority task. This is
called Priority Inversion and is described in Section 4.3.3.

Both Hwis and Swis can interact with the SYS/BIOS task scheduler. When a task is blocked, it is often
because the task is pending on a semaphore which is unavailable. Semaphores can be posted from Hwis
and Swis as well as from other tasks. If a Hwi or Swi posts a semaphore to unblock a pending task, the
processor switches to that task if that task has a higher priority than the currently running task (after the
Hwi or Swi completes).

When running either a Hwi or Swi, SYS/BIOS uses a dedicated system interrupt stack, called the system
stack (sometimes called the ISR stack). Each task uses its own private stack. Therefore, if there are no
Tasks in the system, all threads share the same system stack. For performance reasons, sometimes it is
advantageous to place the system stack in precious fast memory. See Section 3.5.3 for information about
system stack size and Section 3.6.3 for information about task stack size.

Table 3-2 shows what happens when one type of thread is running (top row) and another thread becomes
ready to run (left column). The action shown is that of the newly posted (ready to run) thread.
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Table 3-2. Thread Preemption

Running Thread
Newly Posted Thread Hwi Swi Task Idle
Enabled Hwi Preempts if Preempts Preempts Preempts
enabled”
Disabled Hwi Waits for Waits for Waits for Waits for
reenable reenable reenable reenable
Enabled, higher-priority Swi Waits Preempts Preempts Preempts
Lower-priority Swi Waits Waits Preempts Preempts
Enabled, higher-priority Task Waits Waits Preempts Preempts
Low-priority Task Waits Waits Waits Preempts

* On some targets, hardware interrupts can be individually enabled and disabled. This is not true on all
targets. Also, some targets have controllers that support hardware interrupt prioritization, in which case
a Hwi can only be preempted by a higher-priority Hwi.

Note that Table 3-2 shows the results if the type of thread that is posted is enabled. If that thread type is

disabled (for example, by Task_disable), a thread cannot run case until its thread type is reenabled.

Figure 3-2 shows the execution graph for a scenario in which Swis and Hwis are enabled (the default),

and a Hwi posts a Swi whose priority is higher than that of the Swi running when the interrupt occurs.

Also, a second Hwi occurs while the first ISR is running and preempts the first ISR.

Thread Priority

AHardware interrupt 1
(Hwi 1)

Hardware interrupt 2
(Hwi 2)

Software interrupt A
(Swi A)

Increasing Priority

Software interrupt B
(Swi B)

Figure 3-2. Preemption Scenario
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In Figure 3-2, the low-priority Swi is asynchronously preempted by the Hwis. The first Hwi posts a higher-
priority Swi, which is executed after both Hwis finish executing.

Here is sample pseudo-code for the example depicted in Figure 3-2:

backgr oundThr ead()
{
Swi_post(Swi _B) /* priority =5 */
}
Hai 1 ()
{
}
Hai 2 ()
{
Swi _post(Swi _A) /* priority =7 */
}
3.26  Hooks
Hwi, Swi, and Task threads optionally provide points in a thread's life cycle to insert user code for
instrumentation, monitoring, or statistics gathering purposes. Each of these code points is called a "hook"
and the user function provided for the hook is called a "hook function".
The following hook functions can be set for the various thread types:
Table 3-3. Hook Functions by Thread Type

Thread Type Hook Functions

Hwi Register, Create, Begin, End, and Delete. See Section 3.4.3.

Swi Register, Create, Ready, Begin, End, and Delete. See Section 3.5.8.

Task Register, Create, Ready, Switch, Exit, and Delete. See Section 3.6.5.
Hooks are declared as a set of hook functions called "hook sets". You do not need to define all hook
functions within a set, only those that are required by the application.
Hook functions can only be declared statically (in a configuration script) so that they may be efficiently
invoked when provided and result in no runtime overhead when a hook function is not provided.
Except for the Register hook, all hook functions are invoked with a handle to the object associated with
that thread as its argument (that is, a Hwi object, a Swi object, or a Task object). Other arguments are
provided for some thread-type-specific hook functions.
You can define as many hook sets as necessary for your application. When more than one hook set is
defined, the individual hook functions within each set are invoked in hook ID order for a particular hook
type. For example, during Task_create() the order that the Create hook within each Task hook set is
invoked is the order in which the Task hook sets were originally defined.
The argument to a thread's Register hook (which is invoked only once) is an index (the "hook ID")
indicating the hook set's relative order in the hook function calling sequence.
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Each set of hook functions has a unique associated "hook context pointer". This general-purpose pointer
can be used by itself to hold hook set specific information, or it can be initialized to point to a block of
memory allocated by the Create hook function within a hook set if more space is required for a particular
application.

An individual hook function obtains the value of its associated context pointer through the following
thread-type-specific APIs: Hwi_getHookContext(), Swi_getHookContext(), and Task_getHookContext().
Corresponding APlIs for initializing the context pointers are also provided: Hwi_setHookContext(),
Swi_setHookContext(), and Task_setHookContext(). Each of these APIs take the hook ID as an
argument.

The following diagram shows an application with three Hwi hook sets:
Hwi Hook Set [0]

Hwi Hook Set [1] Hwi Hook Set [2]

registerHookFuncoO () registerHookFuncl () registerHookFunc2 ()
createHookFuncO () createHookFuncl () createHookFunc? ()
beginHookFuncO () beginHookFuncl () beginHookFunc?2 ()
endHookFuncoO () endHookFuncl () endHookFunc? ()
deleteHookFuncoO () deleteHookFuncl () deleteHookFunc2 ()
/
Hwi getHookContext (1)
Hwi getHookContext (0)
l Hwi getHookContext (2)

hookContextPtr[0]

hookContextPtr[1]

hookContextPtr[2]

The hook context pointers are accessed using Hwi_getHookContext() using the index provided to the
three Register hook functions.

Just prior to invoking your ISR functions, the Begin Hook functions are invoked in the following order:

1. beginHookFuncO();
2. beginHookFunc1();
3. beginHookFunc2();

Likewise, upon return from your ISR functions the End Hook functions are invoked in the following order:

1. endHookFuncO0();
2. endHookFunc1();
3. endHookFunc2();
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3.3

3.4

Using SYS/BIOS on SMP Systems

SYS/BIOS can be used on Symmetric Multiprocessing (SMP) systems, such as dual-core ARM Cortex-
M3/M4 and multi-core ARM Cortex-A15 sub-systems present on several TI SoC devices. Such systems
are composed of two or more identical processor cores that share a common view of memory and
peripherals. SMP/BIOS is an operational mode of SYS/BIOS that supports such systems.

APls and configuration parameters in the BIOS, Core, Task, Idle, and Hwi modules let you control the
multi-core behavior of SMP/BIOS.

Hardware Interrupts

Hardware interrupts (Hwis) handle critical processing that the application must perform in response to
external asynchronous events. The SYS/BIOS target/device specific Hwi modules are used to manage
hardware interrupts.

In a typical embedded system, hardware interrupts are triggered either by on-device peripherals or by
devices external to the processor. In both cases, the interrupt causes the processor to vector to the ISR
address.

Any interrupt processing that may invoke SYS/BIOS APIs that affect Swi and Task scheduling must be
written in C or C++. The HWI_enter()/HWI_exit() macros provided in earlier versions of SYS/BIOS for
calling assembly language ISRs are no longer provided.

Assembly language ISRs that do not interact with SYS/BIOS can be specified with Hwi_plug(). Such ISRs
must do their own context preservation. They may use the "interrupt" keyword, C functions, or assembly
language functions.

All hardware interrupts run to completion. If a Hwi is posted multiple times before its ISR has a chance to
run, the ISR runs only one time. For this reason, you should minimize the amount of code performed by
a Hwi function.

If interrupts are globally enabled—that is, by calling Hwi_enable()—an ISR can be preempted by any
interrupt that has been enabled.

Hwis must not use the Chip Support Library (CSL) for the target. Instead, see Chapter 8 for a description
of Hardware Abstraction Layer APls.

Associating an ISR function with a particular interrupt is done by creating a Hwi object.
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3.4.1 Creating Hwi Objects
The Hwi module maintains a table of pointers to Hwi objects that contain information about each Hwi
managed by the dispatcher (or by generated interrupt stubs on platforms for which the Hwi dispatcher is
not provided, such as the MSP430). To create a Hwi object dynamically, use calls similar to these:
Hwi _Handl e hwi O;
Hwi _Par ans hwi Par ans;
Error _Bl ock eb;
Error_init(&eb);
Hwi _Par ans_i ni t (&wi Par ans) ;
hwi Parans. arg = 5;
hwi 0 = HM _create(id, hw Func, &hwi Parans, &eb);
if (hwi0 == NULL) {
System abort ("HM create failed");
}
Here, hwi0 is a handle to the created Hwi object, id is the interrupt number being defined, hwiFunc is the
name of the function associated with the Hwi, and hwiParams is a structure that contains Hwi instance
parameters (enable/restore masks, the Hwi function argument, etc). Here, hwiParams.arg is set to 5. If
NULL is passed instead of a pointer to an actual Hwi_Params struct, a default set of parameters is used.
The "eb" is an error block that you can use to handle errors that may occur during Hwi object creation.
The corresponding static configuration Hwi object creation syntax is:
var HwM = xdc. useModul e('ti.sysbios.hal.Hwi'");
var hwi Parans = new Hw . Par ans;
hwi Parans. arg = 5;
Program gl obal . hwi 0 = Hwi . create(id, '&hw Func', hw Parans);
Here, the "hwiParams = new Hwi.Params" statement does the equivalent of creating and initializing the
hwiParams structure with default values. In the static configuration world, no error block (eb) is required
for the "create" function. The "Program.global.hwi0" name becomes a a runtime-accessible handle
(symbol name = "hwi0") to the statically-created Hwi object.
For information about the parameter structure and individual parameters for instances of this module, see
the API Reference Help System described in Section 1.6.1.
3.4.2 Hardware Interrupt Nesting and System Stack Size
When a Hwi runs, its function is invoked using the system stack. In the worst case, each Hwi can result
in a nesting of the scheduling function (that is, the lowest priority Hwi is preempted by the next highest
priority Hwi, which, in turn, is preempted by the next highest, ...). This results in an increasing stack size
requirement for each Hwi priority level actually used.
The default system stack size is 4096 bytes. You can set the system stack size by adding the following
line to your config script:
Program st ack = your St ackSi ze;
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The following table shows the amount of system stack required to absorb the worst-case Hwi interrupt
nesting. This first number is the amount of system stack space required for the first priority level on a
target. The second number shows the amount of stack space required for each subsequent priority level

used in the application.

Table 3—4. System Stack Use for Hwi Nesting by Target Family

Stack Consumed by  Stack Consumed by

Target Family First Hwi Subsequent Nested Hwis Units

M3 176 80 8-bit bytes
MSP430 36 26 8-bit bytes
MSP430X 38 46 8-bit bytes
MSP430X_small 36 26 8-bit bytes
C674 68 384 8-bit bytes
C64P 68 384 8-bit bytes
C64T 68 208 8-bit bytes
C28_float 65 60 16-bit words
C28 large 65 46 16-bit words
Arm9 136 80 8-bit bytes
A8BF 136 144 8-bit bytes

See Section 3.5.3 for information about system stack use by software interrupts and Section 3.6.3 for
information about task stack size.

3.4.3 Hwi Hooks
The Hwi module supports the following set of Hook functions:
® Register. A function called before any statically created Hwis are initialized at runtime. The register
hook is called at boot time before main() and before interrupts are enabled.
® Create. A function called when a Hwi is created. This includes Hwis that are created statically and
those created dynamically using Hwi_create().
® Begin. A function called just prior to running a Hwi ISR function.
® End. A function called just after a Hwi ISR function finishes.
® Delete. A function called when a Hwi is deleted at runtime with Hwi_delete().
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3.4.3.2

3.4.3.3

The following HookSet structure type definition encapsulates the hook functions supported by the Hwi
module:

typedef struct Hwi _HookSet {

Void (*registerFxn)(Int); /* Regi ster Hook */
Voi d (*createFxn)(Handl e, Error.Block *); /* Create Hook */
Voi d (*begi nFxn) (Handl e); /* Begin Hook */
Voi d (*endFxn) (Handl e); /* End Hook */

Voi d (*del et eFxn) (Handl e) ; /* Del ete Hook */

b

Hwi Hook functions can only be configured statically.

Register Function

The register function is provided to allow a hook set to store its corresponding hook ID. This ID can be
passed to Hwi_setHookContext() and Hwi_getHookContext() to set or get hook-specific context. The
Register function must be specified if the hook implementation needs to use Hwi_setHookContext() or
Hwi_getHookContext().

The registerFxn hook function is called during system initialization before interrupts have been enabled.

The Register function has the following signature:

Voi d registerFxn(lnt id);

Create and Delete Functions

The Create and Delete functions are called whenever a Hwi is created or deleted. The Create function is
passed an Error_Block that is to be passed to Memory_alloc() for applications that require additional
context storage space.

The createFxn and deleteFxn functions are called with interrupts enabled (unless called at boot time or
from main()).

These functions have the following signatures:

Void createFxn(Hwi _Handl e hwi, Error_Bl ock *eb);
Voi d del et eFxn(Hwi _Handl e hwi );

Begin and End Functions

The Begin and End hook functions are called with interrupts globally disabled. As a result, any hook
processing function contributes to overall system interrupt response latency. In order to minimize this
impact, carefully consider the processing time spent in a Hwi beginFxn or endFxn hook function.

The beginFxn is invoked just prior to calling the ISR function. The endFxn is invoked immediately after
the return from the ISR function.

These functions have the following signatures:

Voi d begi nFxn(Hw _Handl e hwi);
Voi d endFxn(Hw _Handl e hwi);

When more than one Hook Set is defined, the individual hook functions of a common type are invoked in
hook ID order.
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3.4.3.4 Hwi Hooks Example

The following example application uses two Hwi hook sets. The Hwi associated with a statically-created
Timer is used to exercise the Hwi hook functions. This example demonstrates how to read and write the
Hook Context Pointer associated with each hook set.

The configuration script and program output are shown after the C code listing.

This is the C code for the example:

[ * ======== Hw |—bokExan‘p| @e.C ========
* This exanpl e denonstrates basic HM hook usage. */

#
#
#
#

ncl ude <xdc/std. h>

ncl ude <xdc/runtime/Error. h>

ncl ude <xdc/runti me/ System h>
ncl ude <xdc/runti me/ Ti nest anp. h>

#
#
#
#

ncl ude <ti/sysbi os/ Bl CS. h>

ncl ude <ti/sysbi os/ knl/ Task. h>
ncl ude <ti/sysbi os/hal/Tiner. h>
ncl ude <ti/sysbi os/ hal /Hwi . h>

extern Tiner_Handl e nyTi ner;
vol atil e Bool nyEnd2Fl ag = FALSE;
I nt nyHookSet | dl, myHookSet! d2;

/* HookSet 1 functions */

| * ======== nyReg| sterl ========

* invoked during Hwi nodul e startup before main()
* for each HookSet */

Voi d nyRegi ster1(lnt hookSetld)

{
System printf("myRegi sterl: assigned hookSet Id = %\ n", hookSetld);
nyHookSet 1 d1 = hookSet | d;

}

| * ======== n’yCr eatel ========

* invoked during HM nodul e startup before main()
* for statically created Hwis */
Void nmyCreatel(Hwi _Handl e hwi, Error_Bl ock *eb)

{
Ptr pEnv;
pEnv = Hw _get HookCont ext (hwi , myHookSet | d1) ;
/* pEnv should be 0 at this point. If not, there's a bug. */
Systemprintf("nyCreatel: pEnv = Ox%, time = %\n", pEnv, Tinestanp_get32());
Hwi _set HookCont ext (hwi, nyHookSet|dl1, (Ptr)Oxdeadl);

}
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/

{

/

{

/
/

* ======== n‘yBeg| nl ========
* invoked before Tinmer Hwi func */

Voi d nyBegi n1(Hwi _Handl e hwi)

Ptr pEnv;

pEnv = Hw _get HookCont ext (hwi , myHookSet | d1);

System printf("nyBeginl: pEnv = Ox%, time = %\ n",

Hwi _set HookCont ext (hwi , myHookSet | d1, (Ptr)Oxbeefl);
] n’yEndl —=======

* invoked after Tiner Hw func */

Voi d nyEnd1(Hw _Handl e hwi)

Ptr pEnv;

pEnv = Hw _get HookCont ext (hwi , myHookSet | d1) ;

pEnv,

System printf("nmyEndl: pEnv = Ox%, time = %\n", pEnv, Ti

Hwi _set HookCont ext (hwi , myHookSet | d1, (Ptr)0OxcOdel);

* HookSet 2 functions */

* —o——————= WRegl ster?2 ========

* invoked during HM nodule startup before main
* for each HookSet */

Voi d nyRegi ster2(lnt hookSetld)

Ti nest anp_get 32() ) ;

nmest anp_get 32() ) ;

{
System printf("nmyRegister2: assigned hookSet Id = %\ n", hookSetld);
nyHookSet | d2 = hookSet | d;
}
[* ======== nyCreate2 ========
* invoked during HM nodul e startup before main
* for statically created Hwis */
Voi d nyCreate2(Hw _Handl e hwi, Error_Bl ock *eb)
{
Ptr pEnv;
pEnv = Hwi _get HookCont ext (hwi , myHookSet | d2);
/* pEnv should be O at this point. If not, there's a bug. */
System printf("myCreate2: pEnv = Ox%, time = %\ n", pEnv, Tinestanp_get32());
Hwi _set HookCont ext (hwi , myHookSet | d2, (Ptr)Oxdead2);
}
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| * ======== nyBeginz —=======
* invoked before Timer Hwi func */
Voi d nyBegi n2(Hwi _Handl e hwi )

{
Ptr pEnv;
pEnv = Hw _get HookCont ext (hwi , myHookSet | d2);
System printf("nyBegi n2: pEnv = Ox%, time = %\ n", pEnv, Tinmestanp_get32());
Hwi _set HookCont ext (hwi , myHookSet | d2, (Ptr)Oxbeef?2);
}
| * ======== nyEndz —=—======

* invoked after Timer HM func */
Voi d nyEnd2(Hni _Handl e hwi )

{
Ptr pEnv;
pEnv = Hw _get HookCont ext (hwi , myHookSet | d2);
System printf("nmyEnd2: pEnv = Ox%, tinme = %\n", pEnv,
Hwi _set HookCont ext (hwi , myHookSet | d2, (Ptr)0xc0de2);
nyEnd2Fl ag = TRUE;

}

| * ======== nyTinErFunc —=======

* Timer interrupt handler */
Voi d nyTi mer Func(UArg ar Q)

{
System printf("Entering nyTinerHu \n");
}
| * ======== nyTaskFunC —======= */
Voi d nyTaskFunc(UArg arg0, UArg argl)
{
System printf("Entering nyTask.\n");
Timer_start(nyTiner);
/* wait for tinmer interrupt and nyEnd2 to conplete */
whil e (!nyEnd2Fl ag) {
}
System printf("nyTask exiting ...\n");
}

Ti nestanp_get 32() ) ;

64

Threading Modules

SPRUEX3V—June 2020
Submit Documentation Feedback


http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SPRUEX3V
http://www.ti.com

13 TEXAS

INSTRUMENTS
www.ti.com Hardware Interrupts
| * ======== n‘y| dl eFunc ======== */
Voi d nyl dl eFunc()
{

System printf("Entering nyldleFunc().\n");
System exit (0);

}
* ==== mai n */

Int main(lnt argc, Char* argv[])

{
System printf("Starti ng HuM HookExanple...\n");
Bl OS_start();
return (0);

}

This is the configuration script for the example:

/* pull in Timestanp to print tinme in hook functions */
xdc. useModul e(' xdc. runti me. Ti mestanp' ) ;

/* Disable Cock so that ours is the only Tiner allocated */
var BI OGS = xdc. useMdul e('ti.syshios.BICS );
Bl CS. cl ockEnabl ed = fal se;

var ldle = xdc.useMdul e('ti.syshios.knl.Idle");
I dl e. addFunc(' &yl dl eFunc');

/* Create nyTask with default task parans */

var Task = xdc.useMdul e('ti.syshios. knl. Task');

var taskParans = new Task. Parans();

Program gl obal . nyTask = Task. create(' &yTaskFunc', taskParans);

/* Create nyTinmer as source of Hwi */

var Timer = xdc.useMdul e('ti.sysbios.hal.Tiner');

var timerParans = new Tinmer. Parans();

ti mer Parans. start Mode = Tiner. Start Mode_USER;

ti mer Par ans. runMbde = Ti mer. RunMbde_ONESHCT;

ti mer Parans. period = 1000; // 1ms

Program gl obal . nyTi mer = Tinmer.create(Tiner. ANY, "&myTi nerFunc", timerParans);

/* Define and add two Hwi HookSets

* Notice, no deleteFxn is provided.

*/

var HwM = xdc. useModul e('ti.sysbios.hal.Hwi'");
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3.5

/* Hook Set 1 */

Hwi . addHookSet ( {
regi sterFxn: ' &nyRegisterl',
createFxn: '&nyCreatel',
begi nFxn: ' &myBegi nl',
endFxn: ' &nyEndl',

s

/* Hook Set 2 */

Hwi . addHook Set ( {
regi ster Fxn: ' &nyRegi ster2',
createFxn: '&nmyCreate?',
begi nFxn: ' &mryBegi n2',
endFxn: ' &ryEnd2',

1),

The program output is as follows, though the number of myCreate calls may be different on different
devices:

nyRegi ster1: assigned hookSet Id = 0
nyRegi ster2: assigned hookSet Id =1
nyCreatel: pEnv = 0x0, tine =0
nyCreate2: pEnv = 0x0, tine =0
Starting Hw HookExanpl e. ..

Enteri ng nmyTask.

nyBegi nl1: pEnv = Oxdeadl, tinme = 75415

nyBegi n2: pEnv = Oxdead2, tinme = 75834
Entering nyTi mer HuM

nyEndl: pEnv Oxbeef 1, time
nyEnd2: pEnv Oxbeef 2, time
nyTask exiting ...

76427
76830

Entering nyl dl eFunc().

Software Interrupts

Software interrupts are patterned after hardware ISRs. The Swi module in SYS/BIOS provides a software
interrupt capability. Software interrupts are triggered programmatically, through a call to a SYS/BIOS API
such as Swi_post(). Software interrupts have priorities that are higher than tasks but lower than hardware
interrupts. See the video introducing Swis for an overview.

Note: The Swi module should not be confused with the SWI instruction that exists on many
processors. The SYS/BIOS Swi module is independent from any target/device-specific
software interrupt features.

Swi threads are suitable for handling application tasks that occur at slower rates or are subject to less
severe real-time deadlines than those of Hwis.
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The SYS/BIOS APIs that can trigger or post a Swi are:

Swi_andn()
Swi_dec()
Swi_inc()
Swi_or()
Swi_post()

The Swi manager controls the execution of all Swi functions. When the application calls one of the APIs
above, the Swi manager schedules the function corresponding to the specified Swi for execution. To
handle Swi functions, the Swi manager uses Swi objects.

If a Swi is posted, it runs only after all pending Hwis have run. A Swi function in progress can be
preempted at any time by a Hwi; the Hwi completes before the Swi function resumes. On the other hand,
Swi functions always preempt tasks. All pending Swis run before even the highest priority task is allowed
to run. In effect, a Swi is like a task with a priority higher than all ordinary tasks.

Note: Two things to remember about Swi functions are:

A Swi function runs to completion unless it is interrupted by a Hwi or preempted by a
higher-priority Swi.

Any hardware ISR that triggers or posts a Swi must have been invoked by the Hwi
dispatcher (or by generated interrupt stubs on platforms for which the Hwi dispatcher is
not provided, such as the MSP430). That is, the Swi must be triggered by a function
called from a Hwi object.

Creating Swi Objects

As with many other SYS/BIOS objects, you can create Swi objects either dynamically—with a call to
Swi_create()—or statically in the configuration. Swis you create dynamically can also be deleted during
program execution.

To add a new Swi to the configuration, create a new Swi object in the configuration script. Set the function
property for each Swi to run a function when the object is triggered by the application. You can also
configure up to two arguments to be passed to each Swi function.

As with all modules with instances, you can determine from which memory segment Swi objects are
allocated. Swi objects are accessed by the Swi manager when Swis are posted and scheduled for
execution.

For complete reference information on the Swi API, configuration, and objects, see the Swi module in the
"ti.sysbios.knl" package documentation in the online documentation. (For information on running online
help, see Section 1.6.1, Using the API Reference Help System, page 25.)
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3.5.2

To create a Swi object dynamically, use a call with this syntax:

Swi _Handl e swi 0;
Swi _Par ans swi Par ans;
Error_Bl ock eb;

Error_init(&eb);
Swi _Parans_i nit(&sw Par ans) ;

swi 0 = Swi _create(sw Func, &sw Parans, &eb);
if (swiO == NULL) {
System abort("Sw create failed");

}

Here, swi0 is a handle to the created Swi object, swiFunc is the name of the function associated with the
Swi, and swiParams is a structure of type Swi_Params that contains the Swi instance parameters
(priority, arg0, arg1, etc). If NULL is passed instead of a pointer to an actual Swi_Params struct, a default
set of parameters is used. "eb" is an error block you can use to handle errors that may occur during Swi
object creation.

Note: Swi_create() cannot be called from the context of a Hwi or another Swi thread.
Applications that dynamically create Swi threads must do so from either the context of
the main() function or a Task thread.

For information about the parameter structure and individual parameters for instances of this module, see
the API Reference Help System described in Section 1.6.1.

To create a Swi object in a configuration file, use statements like these:

var Swi = xdc.useMdul e('ti.syshios.knl.Swi");
var sw Parans = new Sw . Parans();
program gl obal . swi 0 = Swi . creat e(sw Parans);

Setting Software Interrupt Priorities

There are different priority levels among Swis. You can create as many Swis as your memory constraints
allow for each priority level. You can choose a higher priority (higher priority number) for a Swi that
handles a thread with a shorter real-time deadline, and a lower priority for a Swi that handles a thread
with a less critical execution deadline.

The number of Swi priorities supported within an application is configurable up to a maximum 32. The
maximum number of priority levels is 16 for MSP430 and C28x. The default number of priority levels is 16. The
lowest priority level is 0. Thus, by default, the highest priority level is 15.

You cannot sort Swis within a single priority level. They are serviced in the order in which they were
posted.
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3.5.3

Software Interrupt Priorities and System Stack Size

When a Swi is posted, its associated Swi function is invoked using the system stack. While you can have
up to 32 Swi priority levels on some targets, keep in mind that in the worst case, each Swi priority level
can result in a nesting of the Swi scheduling function (that is, the lowest priority Swi is preempted by the
next highest priority Swi, which, in turn, is preempted by the next highest, ...). This results in an increasing
stack size requirement for each Swi priority level actually used. Thus, giving Swis the same priority level
is more efficient in terms of stack size than giving each Swi a separate priority.

The default system stack size is 4096 bytes. You can set the system stack size by adding the following
line to your config script:

Program stack = your St ackSi ze;

Note: The Clock module creates and uses a Swi with the maximum Swi priority (that is, if
there are 16 Swi priorities, the Clock Swi has priority 15).

The following table shows the amount of system stack required to absorb the worst-case Swi interrupt
nesting. This first number is the amount of system stack space required for the first priority level on a
target. The second number shows the amount of stack space required for each subsequent priority level
used in the application.

Table 3-5. System Stack Use for Swi Nesting by Target Family

Stack Consumed by Stack Consumed by

Target Family First Priority Level Subsequent Priority Levels  Units

M3 104 88 8-bit bytes
MSP430 78 32 8-bit bytes
MSP430X 90 60 8-bit bytes
MSP430X_small 78 32 8-bit bytes
C674 108 120 8-bit bytes
C64P 108 120 8-bit bytes
C64T 108 120 8-bit bytes
C28 float 83 40 16-bit words
C28_large 81 34 16-bit words
Arm9 104 80 8-bit bytes
A8F 160 72 8-bit bytes

See Section 3.4.2 for information about system stack use by Hwis and Section 3.6.3 for information about
task stack size.
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Execution of Software Interrupts

Swis can be scheduled for execution with a call to Swi_andn(), Swi_dec(), Swi_inc(), Swi_or(), and
Swi_post(). These calls can be used virtually anywhere in the program—Hwi functions, Clock functions,
Idle functions, or other Swi functions.

When a Swi is posted, the Swi manager adds it to a list of posted Swis that are pending execution. The
Swi manager checks whether Swis are currently enabled. If they are not, as is the case inside a Hwi
function, the Swi manager returns control to the current thread.

If Swis are enabled, the Swi manager checks the priority of the posted Swi object against the priority of
the thread that is currently running. If the thread currently running is the background Idle Loop, a Task,

or a lower priority Swi, the Swi manager removes the Swi from the list of posted Swi objects and switches
the CPU control from the current thread to start execution of the posted Swi function.

If the thread currently running is a Swi of the same or higher priority, the Swi manager returns control to
the current thread, and the posted Swi function runs after all other Swis of higher priority or the same
priority that were previously posted finish execution.

When multiple Swis of the same priority level have been posted, their respective Swi functions are
executed in the order the Swis were posted.

There are two important things to remember about Swi:
® When a Swi starts executing, it must run to completion without blocking.

® When called from within a hardware ISR, the code calling any Swi function that can trigger or post a
Swi must be invoked by the Hwi dispatcher (or by generated interrupt stubs on platforms for which
the Hwi dispatcher is not provided, such as the MSP430). That is, the Swi must be triggered by a
function called from a Hwi object.

Swi functions can be preempted by threads of higher priority (such as a Hwi or a Swi of higher priority).
However, Swi functions cannot block. You cannot suspend a Swi while it waits for something—like a
device—to be ready.

If a Swi is posted multiple times before the Swi manager has removed it from the posted Swi list, its Swi
function executes only once, much like a Hwi is executed only once if the Hwi is triggered multiple times
before the CPU clears the corresponding interrupt flag bit in the interrupt flag register. (See Section 3.5.5
for more information on how to handle Swis that are posted multiple times before they are scheduled for
execution.)

Applications should not make any assumptions about the order in which Swi functions of equal priority
are called. However, a Swi function can safely post itself (or be posted by another interrupt). If more than
one is pending, all Swi functions are called before any tasks run.
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3.55

Using a Swi Object’s Trigger Variable

Each Swi object has an associated 32-bit trigger variable for C6x targets and a 16-bit trigger variable for
C5x, C28x, and MSP430 targets. This is used either to determine whether to post the Swi or to provide
values that can be evaluated within the Swi function.

Swi_post(), Swi_or(), and Swi_inc() post a Swi object unconditionally:
¢ Swi_post() does not modify the value of the Swi object trigger when it is used to post a Swi.

¢ Swi_or() sets the bits in the trigger determined by a mask that is passed as a parameter, and then
posts the Swi.

® Swi_inc() increases the Swi's trigger value by one before posting the Swi object.
¢ Swi_andn() and Swi_dec() post a Swi object only if the value of its trigger becomes 0:
¢ Swi_andn() clears the bits in the trigger determined by a mask passed as a parameter.

® Swi_dec() decreases the value of the trigger by one.

Table 3-6 summarizes the differences between these functions.

Table 3-6. Swi Object Function Differences

Treats Treats Does not

Trigger as Trigger as Modify
Action Bitmask Counter Trigger
Always post Swi_or() Swi_inc() Swi_post()
Post if it becomes zero Swi_andn() Swi_dec() —

The Swi trigger allows you to have tighter control over the conditions that should cause a Swi function to
be posted, or the number of times the Swi function should be executed once the Swi is posted and
scheduled for execution.

To access the value of its trigger, a Swi function can call Swi_getTrigger(). Swi_getTrigger() can be called
only from the Swi object’s function. The value returned by Swi_getTrigger() is the value of the trigger
before the Swi object was removed from the posted Swi queue and the Swi function was scheduled for
execution.

When the Swi manager removes a pending Swi object from the posted object’s queue, its trigger is reset
to its initial value. The initial value of the trigger should be set in the application’s configuration script. If
while the Swi function is executing, the Swi is posted again, its trigger is updated accordingly. However,
this does not affect the value returned by Swi_getTrigger() while the Swi function executes. That is, the
trigger value that Swi_getTrigger() returns is the latched trigger value when the Swi was removed from
the list of pending Swis. The Swi's trigger however, is immediately reset after the Swi is removed from
the list of pending Swis and scheduled for execution. This gives the application the ability to keep
updating the value of the Swi trigger if a new posting occurs, even if the Swi function has not finished its
execution.
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For example, if a Swi object is posted multiple times before it is removed from the queue of posted Swis,
the Swi manager schedules its function to execute only once. However, if a Swi function must always run
multiple times when the Swi object is posted multiple times, Swi_inc() should be used to post the Swi as

shown in Figure 3-3.

When a Swi has been posted using Swi_inc(), once the Swi manager calls the corresponding Swi
function for execution, the Swi function can access the Swi object trigger to know how many times it was
posted before it was scheduled to run, and proceed to execute the same function as many times as the

value of the trigger.

Figure 3-3. Using Swi_inc() to Post a Swi

Program Configuration Trigger | Value returned by
Swi object mySwi Value Swi_getTrigger
Function mySwiFxn 0 not callable
outside Swi
Program . ) not callable
Execution| | - Calls Swi_inc(&mySwi) 1 X .
-- mySwi is posted ueie
-- Calls Swi_inc(&mySwi) 2 not callable
-- mySwi is posted again before it is outside Swi
scheduled for execution
-- Swi manager removes mySwi from 0 2
posted Swi queue
-- mySwiFxn is scheduled for execution
-- mySwiFxn begins execution 0 2
-- mySwiFxn is preempted by ISR that 1 2
calls Swi_inc(&mySwi)
-- mySwi is added to posted Swi queue
| Al mySwiFxn continues execution 1 2

mySwiFxn ()
repetitions = SWI getTrigger() ;
while (repetitions --) ({
'run Swi function'
}
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If more than one event must always happen for a given Swi to be triggered, Swi_andn() should be used
to post the corresponding Swi object as shown in Figure 3-4. For example, if a Swi must wait for input
data from two different devices before it can proceed, its trigger should have two set bits when the Swi
object is configured. When both functions that provide input data have completed their tasks, they should
both call Swi_andn() with complementary bitmasks that clear each of the bits set in the Swi trigger default
value. Hence, the Swi is posted only when data from both processes is ready.

Figure 3-4. Using Swi_andn() to Post a Swi

Program Configuration | Trigger Value returned by
Swi object mySwi Value Swi_getTrigger
Function mySwiFxn ‘0 ‘ ‘ 1 ‘ 1 ‘ ‘not callable‘
outside Swi
Program
Exeauion| | - Calls Swi_andn(&myswi, 0x1) ‘o ‘ ‘ 1 ‘ 0‘ ‘gzts‘l’jgasb\':
-- mySwi is not posted
- Calls Swi_andn(&mySwi, 0x2) ‘ 0 ‘ ‘ 0 ‘ 0 ‘ ‘gﬁts‘l’jgasb\':
-- mySwi is posted
-- Swi manager removes mySwi from ‘ 0 ‘ ‘ 1 ‘ 1 ‘ ‘ 0 ‘ ‘ 0 ‘ 0 ‘
posted Swi queue
-- mySwiFxn is scheduled for execution
| i mySwiFxn begins execution ‘ 0 ‘ ‘ 1 ‘ 1 ‘ ‘ 0 ‘ ‘ 0 ‘ 0 ‘

If the program execution requires that multiple occurrences of the same event must take place before a
Swi is posted, Swi_dec() should be used to post the Swi as shown in Figure 3-5. By configuring the Swi
trigger to be equal to the number of occurrences of the event before the Swi should be posted and calling
Swi_dec() every time the event occurs, the Swi is posted only after its trigger reaches 0; that is, after the
event has occurred a number of times equal to the trigger value.

Figure 3-5. Using Swi_dec() to Post a Swi

Value returned by
Swi_getTrigger

not callable
outside Swi
not callable
outside Swi

not callable
outside Swi

o]
o]

Trigger
Value

Program Configuration
Swi object mySwi,
Function mySwiFxn

Program

Execution| | — Calls Swi_dec(&mySwi)

-- mySwi is not posted

-- Calls Swi_dec(&mySwi)
-- mySwi is posted

.

°]

-- Swi manager removes mySwi from
posted Swi queue
-- mySwiFxn is scheduled for execution

\ 2l mySwiFxn begins execution

]

]
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In some situations the Swi function can call different functions depending on the event that posted it. In
that case the program can use Swi_or() to post the Swi object unconditionally when an event happens.
This is shown in Figure 3-6. The value of the bitmask used by Swi_or() encodes the event type that

triggered the post operation, and can be used by the Swi function as a flag that identifies the event and
serves to choose the function to execute.

Figure 3-6. Using Swi_or() to Post a Swi.

Program
Execution

Program Configuration Trigger Value refumed by
Swi object mySwi, Value Swi_getTrigger
Function mySwiFxn ol To not callable

outside Swi

. . t callable

-- Calls Swi_or(&mySwi, 0x1) 0l..l0 notc .

- mySwi is posted outside Swi

-- mySwiFxn is executed 0f...0 0|...0]1

t callabl

— Calls Swi_or(&mySwi, 0x2) 0.1 ootsie Sw
-- mySwi is posted

-- mySwiFxn is executed 0..[0 0/...1]|0

mySwiFxn ()

{

eventType = Swi getTrigger() ;

switch (eventType)

case '0x1': 'run alg 1!
case '0x2': 'run alg 2'
case '0x3': 'run alg 3!

There are several benefits to using Swis instead of Hwis:

By modifying shared data structures in a Swi function instead of a Hwi, you can get mutual exclusion
by disabling Swis while a Task accesses the shared data structure (see page 75). This allows the
system to respond to events in real-time using Hwis. In contrast, if a Hwi function modified a shared
data structure directly, Tasks would need to disable Hwis to access data structures in a mutually
exclusive way. Obviously, disabling Hwis may degrade the performance of a real-time system.

It often makes sense to break long ISRs into two pieces. The Hwi takes care of the extremely time-
critical operation and defers less critical processing to a Swi function by posting the Swi within the

Remember that a Swi function must complete before any blocked Task is allowed to run.

3.5.6 Benefits and Tradeoffs
[ ]
[ ]
Hwi function.
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3.5.7 Synchronizing Swi Functions

Within an Idle, Task, or Swi function, you can temporarily prevent preemption by a higher-priority Swi by
calling Swi_disable(), which disables all Swi preemption. To reenable Swi preemption, call Swi_restore().
Swis are enabled or disabled as a group. An individual Swi cannot be enabled or disabled on its own.

When SYS/BIOS finishes initialization and before the first task is called, Swis have been enabled. If an
application wishes to disable Swis, it calls Swi_disable() as follows:

| key = Swi _disabl e();

The corresponding enable function is Swi_restore() where key is a value used by the Swi module to
determine if Swi_disable() has been called more than once.

| Swi _restore(key);

This allows nesting of Swi_disable() / Swi_restore() calls, since only the outermost Swi_restore() call
actually enables Swis. In other words, a task can disable and enable Swis without having to determine if
Swi_disable() has already been called elsewhere.

When Swis are disabled, a posted Swi function does not run at that time. The interrupt is “latched” in
software and runs when Swis are enabled and it is the highest-priority thread that is ready to run.

To delete a dynamically created Swi, use Swi_delete(). The memory associated with Swi is freed.
Swi_delete() can only be called from the task level.

3.5.8 Swi Hooks

The Swi module supports the following set of Hook functions:

® Register. A function called before any statically created Swis are initialized at runtime. The register
hook is called at boot time before main() and before interrupts are enabled.

® Create. A function called when a Swi is created. This includes Swis that are created statically and
those created dynamically using Swi_create().

® Ready. A function called when any Swi becomes ready to run.
® Begin. A function called just prior to running a Swi function.
® End. Afunction called just after returning from a Swi function.

® Delete. A function called when a Swi is deleted at runtime with Swi_delete().

The following Swi_HookSet structure type definition encapsulates the hook functions supported by the

Swi module:

typedef struct Swi _HookSet {
Void (*registerFxn)(Int); /* Regi ster Hook */
Voi d (*createFxn)(Handl e, Error.Block *); /* Create Hook */
Voi d (*readyFxn) (Handl e); /* Ready Hook */
Voi d (*begi nFxn) (Handl e); /* Begin Hook */
Voi d (*endFxn) (Handl e); /* End Hook */
Voi d (*del et eFxn) (Handl e) ; /* Del ete Hook */

b

Swi Hook functions can only be configured statically.

When more than one Hook Set is defined, the individual hook functions of a common type are invoked in
hook ID order.
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3.5.8.1

3.5.8.2

3.5.8.3

Register Function

The Register function is provided to allow a hook set to store its corresponding hook ID. This ID can be
passed to Swi_setHookContext() and Swi_getHookContext() to set or get hook-specific context. The
Register function must be specified if the hook implementation needs to use Swi_setHookContext() or
Swi_getHookContext().

The registerFxn function is called during system initialization before interrupts have been enabled.

The Register functions has the following signature:

Void registerFxn(Int id);

Create and Delete Functions

The Create and Delete functions are called whenever a Swi is created or deleted. The Create function is
passed an Error_Block that is to be passed to Memory_alloc() for applications that require additional
context storage space.

The createFxn and deleteFxn functions are called with interrupts enabled (unless called at boot time or
from main()).

These functions have the following signatures.

Voi d createFxn(Swi _Handl e swi, Error_Block *eb);
Voi d del et eFxn(Swi _Handl e swi);

Ready, Begin and End Functions

The Ready, Begin and End hook functions are called with interrupts enabled. The readyFxn function is
called when a Swi is posted and made ready to run. The beginFxn function is called right before the
function associated with the given Swi is run. The endFxn function is called right after returning from the
Swi function.

Both readyFxn and beginFxn hooks are provided because a Swi may be posted and ready but still
pending while a higher-priority thread completes.

These functions have the following signatures:

Voi d readyFxn(Sw _Handl e swi);
Voi d begi nFxn(Swi _Handl e swi);

Voi d endFxn(Swi _Handl e swi);
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3.5.8.4 Swi Hooks Example

The following example application uses two Swi hook sets. This example demonstrates how to read and

write the Hook Context Pointer associated with each hook set.
The configuration script and program output are shown after the C code listing.

This is the C code for the example:

| * ======== SW |—bokExan‘p| @e.C ========
* This exanpl e denpbnstrates basic Swi hook usage */

#
#
#
#

ncl ude <xdc/std. h>

ncl ude <xdc/runtime/Error. h>

ncl ude <xdc/runti me/ System h>
ncl ude <xdc/runti me/ Ti nest anp. h>

#
#
#
#

ncl ude <ti/sysbi os/ Bl CS. h>

ncl ude <ti/sysbi os/ knl/ Task. h>
ncl ude <ti/sysbi os/hal/Tiner. h>
ncl ude <ti/sysbi os/knl/Swi . h>

Swi _Handl e nmySwi ;
I nt nyHookSet | dl, myHookSet! d2;

/* HookSet 1 functions */

| * ======== nyReg| sterl ========

* invoked during Swi nodul e startup before main
* for each HookSet */

Voi d nyRegi ster1(lnt hookSetld)

* invoked during Swi _create for dynamically created Swis */
Void nyCreatel(Swi _Handle swi, Error_Block *eb)

{
System printf("nmyRegisterl: assigned hookSet Id = %\n", hookSetld);
nyHookSet 1 d1 = hookSet | d;

}

| * ======== n’yCr eatel ========

{
Ptr pEnv;
pEnv = Swi _get HookCont ext (swi , myHookSet | d1);
/* pEnv should be 0 at this point. If not, there's a bug. */
Systemprintf("nmyCreatel: pEnv = Ox%, time = %\n", pEnv, Tinestanp_get32());
Swi _set HookCont ext (swi, myHookSet | dl, (Ptr)Oxdeadl);

}
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/] * ======== nyReadyl =—=======
* invoked when Swi is posted */
Voi d nyReadyl(Swi _Handl e swi)

{
Ptr pEnv;
pEnv = Swi _get HookCont ext (swi, myHookSet | d1);
System printf("nmyReadyl: pEnv = Ox%, time = %\ n", pEnv, Tinmestanp_get32());
Swi _set HookCont ext (swi, nyHookSet1dl, (Ptr)Oxbeefl);
}
| * ======== nyBeginl —=—======

* invoked just before Swi func is run */
Voi d nyBegi n1(Swi _Handl e swi)

{
Ptr pEnv;
pEnv = Swi _get HookCont ext (swi, myHookSet | dl);
System printf("nmyBeginl: pEnv = Ox%, time = %\ n", pEnv, Tinmestanp_get32());
Swi _set HookCont ext (swi, nyHookSet1dl, (Ptr)Oxfeebl);
}
| * ======== nyEndl —=======

* invoked after Swi func returns */
Voi d nyEnd1(Swi _Handl e swi)

{
Ptr pEnv;
pEnv = Swi _get HookCont ext (swi , myHookSet | d1);
System printf("nmyEndl: pEnv = Ox%, time = %\n", pEnv, Tinestanp_get32());
Swi _set HookCont ext (swi, nyHookSet!dl, (Ptr)Oxc0Odel);
}
| * ======== nyEEletel —=======

* invoked upon Swi del etion */
Voi d nyDel etel(Swi _Handl e swi)

{
Ptr pEnv;
pEnv = Swi _get HookCont ext (swi , myHookSet | d1);
System printf("myDel etel: pEnv = Ox%, time = %\ n", pEnv, Tinestanp_get32());
}
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/* HookSet 2 functions */

| * ======== nyRegi ster2 ========

* invoked during Swi nodule startup before main
* for each HookSet */

Voi d nyRegi ster2(lnt hookSetld)

{
System printf("nyRegister2: assigned hookSet Id = %\ n", hookSetld);
nyHookSet | d2 = hookSet | d;

}

| * ======== n‘yO’ eat e2 ========

* invoked during Sw _create for dynamcally created Swis */
Voi d nyCreate2(Swi _Handle swi, Error_Block *eb)

{
Ptr pEnv;
pEnv = Swi _get HookCont ext (swi, myHookSet | d2);
/* pEnv should be 0 at this point. If not, there's a bug. */
Systemprintf("nmyCreate2: pEnv = Ox%, tinme = %\ n", pEnv, Tinestanp_get32());
Swi _set HookCont ext (swi, nyHookSet1d2, (Ptr)Oxdead?2);

}

| * ======== n’yReadyZ —=======

* invoked when Swi is posted */
Voi d nyReady2(Swi _Handl e swi)

{
Ptr pEnv;
pEnv = Swi _get HookCont ext (swi , myHookSet | d2);
System printf("myReady2: pEnv = Ox%, time = %\ n", pEnv, Timestanp_get32());
Swi _set HookCont ext (swi, nyHookSet1d2, (Ptr)Oxbeef?2);
}
| * ======== n’yBeg| n2 ========

* invoked just before Swi func is run */
Voi d nyBegi n2( Swi _Handl e swi)

{
Ptr pEnv;
pEnv = Swi _get HookCont ext (swi , myHookSet | d2);
System printf("myBegi n2: pEnv = Ox%, time = %\ n", pEnv, Timestanp_get32());
Swi _set HookCont ext (swi, nyHookSet1d2, (Ptr)Oxfeeb2);
}
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| * ======== rTyEndZ —=======
* invoked after Swi func returns */
Voi d nyEnd2(Swi _Handl e swi)

{
Ptr pEnv;
pEnv = Swi _get HookCont ext (swi, myHookSet | d2);
System printf("nmyEnd2: pEnv = Ox%, time = %\n", pEnv, Tinestanp_get32());
Swi _set HookCont ext (swi, nyHookSet1d2, (Ptr)0Oxc0de2);
}
| * ======== rry[):_xl ete2 ========

* invoked upon Swi del etion */
Voi d nyDel et e2(Swi _Handl e swi)

{
Ptr pEnv;
pEnv = Swi _get HookCont ext (swi, myHookSet | d2);
System printf("nmyDel ete2: pEnv = Ox%, tinme = %\ n", pEnv, Tinestanp_get32());
}
| * ======== n’yS\M Func ======== */
Voi d nySwi Func(UArg arg0, UArg argl)
{
System printf("Entering nySwi.\n");
}
| * ======== n’yTaskFunC —======= */
Voi d nyTaskFunc(UArg arg0, UArg argl)
{
System printf("Entering nyTask.\n");
System printf("Posting mySw .\n");
Swi _post (nySwi ) ;
System printf("Deleting nySwi.\n");
Swi _del et e(&rySwi ) ;
System printf("nmyTask exiting ...\n");
}
| * ======== n‘y| dl eFunc ======== */
Voi d nyl dl eFunc()
{
System printf("Entering nyldleFunc().\n");
System exit (0);
}
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[* ==== mai n */
Int main(lnt argc, Char* argv[])
{
Error_Bl ock eb;
Error _init(&eb);
System printf("Starting Swi HookExanple...\n");
/* Create nySwi with default parans
* to exercise Sw Hook Functions */
nySwi = Swi _create(mySw Func, NULL, &eb);
if (mySwi == NULL) {
System abort("Swi create failed");
}
Bl OS_start();
return (0);
}

This is the configuration script for the example:

[* pull in Timestanp to print tinme in hook functions */
xdc. useModul e(' xdc. runti me. Ti mestanp' ) ;

/* Disable Cock so that ours is the only Swi in the application */
var BI OGS = xdc. useMdul e('ti.syshios.BICS);
Bl CS. cl ockEnabl ed = fal se;

var |Idle = xdc.useMdul e('ti.syshios.knl.Idle");
I dl e. addFunc("' &yl dl eFunc');

/* Create nyTask with default task paranms */

var Task = xdc.useMdul e('ti.sysbhios. knl. Task"');

var taskParans = new Task. Parans();

Program gl obal . nyTask = Task. create(' &yTaskFunc', taskParans);

/* Define and add two Swi Hook Sets */
var Swi = xdc. useModul e("ti.sysbios. knl.Sw ");

/* Hook Set 1 */

Swi . addHook Set ({
regi sterFxn: '&nyRegisterl',
createFxn: '&nyCreatel',
readyFxn: ' &myReadyl',
begi nFxn: ' &myBegi nl',
endFxn: ' &ryEndl',
del eteFxn: ' &nyDel etel’

1),
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/* Hook Set 2 */
Swi . addHook Set ({
regi sterFxn: ' &nyRegister2',
createFxn: '&nyCreate?2',
readyFxn: '&myReady2',
begi nFxn: ' &myBegi n2',
endFxn: ' &nyEnd2',
del et eFxn: ' &nyDel et e2'
1
This is the output for the application:
nyRegi ster1l: assigned hookSet Id = 0
nyRegi ster2: assigned hookSet 1d =1
Starting Swi HookExanpl e. ..
nyCreatel: pEnv = 0x0, tine = 315
nyCreate2: pEnv = 0x0, time = 650
Ent eri ng nyTask.
Posting nmySw .
nyReadyl: pEnv = Oxdeadl, tine = 1275
nyReady2: pEnv = Oxdead2, tine = 1678
nyBegi nl: pEnv = Oxbeefl, tine = 2093
nyBegi n2: pEnv = Oxbeef2, tine = 2496
Entering mySwi .
nyEndl: pEnv = Oxfeebl, tinme = 3033
nyEnd2: pEnv = Oxfeeb2, time = 3421
Del eting mySwi .
nyDel etel: pEnv = OxcOdel, time = 3957
nyDel et e2: pEnv = 0OxcOde2, tinme = 4366
nyTask exiting ...
Enteri ng nyl dl eFunc().
3.6 Tasks
SYS/BIOS task objects are threads that are managed by the Task module. Tasks have higher priority than
the Idle Loop and lower priority than hardware and software interrupts. See the video introducing Tasks
for an overview.
The Task module dynamically schedules and preempts tasks based on the task’s priority level and the
task’s current execution state. This ensures that the processor is always given to the highest priority
thread that is ready to run. There are up to 32 priority levels available for tasks, with the default number
of levels being 16. The maximum number of priority levels is 16 for MSP430 and C28x. The lowest priority level
(0) is reserved for running the Idle Loop.
The Task module provides a set of functions that manipulate task objects. They access Task objects
through handles of type Task_Handle.
The kernel maintains a copy of the processor registers for each task object. Each task has its own runtime
stack for storing local variables as well as for further nesting of function calls. See Section 3.6.3 for
information about task stack sizes.
All tasks executing within a single program share a common set of global variables, accessed according
to the standard rules of scope defined for C functions.
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3.6.1 Creating Tasks
You can create Task objects either dynamically with a call to Task_create() or statically in the
configuration. Tasks that you create dynamically can also be deleted during program execution.
3.6.1.1 Creating and Deleting Tasks Dynamically
You can spawn SYS/BIOS tasks by calling the function Task_create(), whose parameters include the
address of a C function in which the new task begins its execution. The value returned by Task_create()
is a handle of type Task_Handle, which you can then pass as an argument to other Task functions.
This C example creates a task:
Task_Parans taskParans;
Task_Handl e t askO;
Error _Bl ock eb;
Error_init(&eb);
/* Create 1 task with priority 15 */
Task_Parans_i ni t (& askPar ans) ;
t askPar ams. st ackSi ze = 512;
taskParans. priority = 15;
task0 = Task_create((Task_FuncPtr) hi Pri Task, &t askParans, &eb);
if (taskO == NULL) {
System abort (" Task create failed");
}
If NULL is passed instead of a pointer to an actual Task_Params struct, a default set of parameters is
used. The "eb" is an error block that you can use to handle errors that may occur during Task object
creation. See Section 3.6.3 for information about task stack sizes.
For information about the parameter structure and individual parameters for instances of this module, see
the API Reference Help System described in Section 1.6.1.
Atask becomes active when it is created and preempts the currently running task if it has a higher priority.
The memory used by Task objects and stacks can be reclaimed by calling Task_delete(). Task_delete()
removes the task from all internal queues and frees the task object and stack.
Any Semaphores or other resources held by the task are not released. Deleting a task that holds such
resources is often an application design error, although not necessarily so. In most cases, such resources
should be released prior to deleting the task. Itis only safe to delete a Task that is either in the Terminated
or Inactive State.
Voi d Task_del et e( Task_Handl e *t ask);
3.6.1.2 Creating Tasks Statically
You can also create tasks statically within a configuration script. The configuration allows you to set a
number of properties for each task and for the Task manager itself.
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3.6.2

For a complete description of all Task properties, see the Task module in the "ti.sysbios.knl" package
documentation in the online documentation. (For information on running online help, see Section 1.6.1,
Using the API Reference Help System, page 25.)

While it is running, a task that was created statically behaves exactly the same as a task created with
Task_create(). You cannot use the Task_delete() function to delete statically-created tasks.

The Task module automatically creates the Task_idle task and gives it the lowest task priority (0). It runs
the functions defined for the Idle objects when no higher-priority Hwi, Swi, or Task is running.

When you configure tasks to have equal priority, they are scheduled in the order in which they are created
in the configuration script. Tasks can have up to 32 priority levels with 16 being the default. The maximum
number of priority levels is 16 for MSP430 and C28x. The highest level is the number of priorities defined
minus 1, and the lowest is 0. The priority level of 0 is reserved for the system idle task. You cannot sort
tasks within a single priority level by setting the order property.

If you want a task to be initially inactive, set its priority to -1. Such tasks are not scheduled to run until
their priority is raised at runtime.

Task Execution States and Scheduling

Each Task object is always in one of four possible states of execution:

®* Task_Mode_RUNNING, which means the task is the one actually executing on the system’s
processor.

®* Task_Mode_READY, which means the task is scheduled for execution subject to processor
availability.

¢* Task_Mode_BLOCKED, which means the task cannot execute until a particular event occurs within
the system.

® Task_Mode_TERMINATED, which means the task is “terminated” and does not execute again.

¢ Task_Mode_INACTIVE, which means the task has a priority equal to -1 and is in a pre-Ready state.
This priority can be set when the task is created or by calling the Task_setPri() API at runtime.

Tasks are scheduled for execution according to a priority level assigned by the application. There can be
no more than one running task. As a rule, no ready task has a priority level greater than that of the
currently running task, since Task preempts the running task in favor of the higher-priority ready task.
Unlike many time-sharing operating systems that give each task its “fair share” of the processor,
SYS/BIOS immediately preempts the current task whenever a task of higher priority becomes ready to
run.

The maximum priority level is Task_numPriorities-1 (default=15; maximum=31). The minimum priority is
1. If the priority is less than 0, the task is barred from further execution until its priority is raised at a later
time by another task. If the priority equals Task_numPriorities-1, the task cannot be preempted by another
task. A highest-priority task can still call Semaphore_pend(), Task_sleep(), or some other blocking call to
allow tasks of lower priority to run. A Task’s priority can be changed at runtime with a call to Task_setPr().
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During the course of a program, each task’s mode of execution can change for a number of reasons.
Figure 3-7 shows how execution modes change.

Figure 3-7. Execution Mode Variations

Task create()
Task is created

Semaphore_post(), ...
Task is readied

Task_Mode READY

Task_yield()

Task_delete() Task is preempted

Task is deleted
Task Mode RUNNING

Task_sleep(),
Task_exit() Semaphore_pend(), ...

Task_Mode TERMINATED
- - Task exits Task suspends

Task_Mode_BLOCKED

Functions in the Task, Semaphore, Event, and Mailbox modules alter the execution state of task objects:
blocking or terminating the currently running task, readying a previously suspended task, re-scheduling
the current task, and so forth.

There is one task whose execution mode is Task_Mode_RUNNING. If all program tasks are blocked and
no Hwi or Swi is running, Task executes the Task_idle task, whose priority is lower than all other tasks in
the system. When a task is preempted by a Hwi or Swi, the task execution mode returned for that task
by Task_stat() is still Task_Mode RUNNING because the task will run when the preemption ends.

Notes: Do not make blocking calls, such as Semaphore_pend() or Task_sleep(), from within
an Idle function. Doing so causes the application to terminate.

When the Task_Mode_RUNNING task transitions to any of the other three states, control switches to the
highest-priority task that is ready to run (that is, whose mode is Task_Mode READY). A
Task_Mode_RUNNING task transitions to one of the other modes in the following ways:

® The running task becomes Task_Mode TERMINATED by calling Task_exit(), which is automatically
called if and when a task returns from its top-level function. After all tasks have returned, the Task
manager terminates program execution by calling System_exit() with a status code of 0.

® The running task becomes Task_Mode BLOCKED when it calls a function (for example,
Semaphore_pend() or Task_sleep() ) that causes the current task to suspend its execution; tasks can
move into this state when they are performing certain 1/0 operations, awaiting availability of some
shared resource, or idling.

® The running task becomes Task_Mode READY and is preempted whenever some other, higher-
priority task becomes ready to run. Task_setPri() can cause this type of transition if the priority of the
current task is no longer the highest in the system. A task can also use Task_yield() to yield to other
tasks with the same priority. A task that yields becomes ready to run.
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A task that is currently Task_Mode BLOCKED transitions to the ready state in response to a particular
event: completion of an I/O operation, availability of a shared resource, the elapse of a specified period
of time, and so forth. By virtue of becoming Task_Mode_READY, this task is scheduled for execution
according to its priority level; and, of course, this task immediately transitions to the running state if its
priority is higher than the currently executing task. Task schedules tasks of equal priority on a first-come,
first-served basis.
3.6.3  Task Stacks
The kernel maintains a copy of the processor registers for each Task object. Each Task has its own
runtime stack for storing local variables as well as for further nesting of function calls.
You can specify the stack size separately for each Task object when you create the Task object statically
or dynamically. Each task stack must be large enough to handle both its normal function calls and two
full interrupting Hwi contexts.
The "Maximum Stack Consumed" column in the following table shows the amount of stack space
required to absorb the worst-case interrupt nesting. These numbers represent two full Hwi interrupt
contexts plus the space used by the task scheduler for its local variables. Additional nested interrupt
contexts are pushed onto the common system stack.
Note that when the kernel is configured such that there are no Task Hooks configured (with
Task. mi ni m zeLat ency = fal se and Bl OS. | ogsEnabl ed = f al se), each task stack must only support
a single full Hwi interrupt context in addition to the task scheduler's local variables. This configuration is
equal to the "Minimum Stack Consumed" in Table 3-7.
Table 3-7. Task Stack Use by Target Family
Target Minimum Stack Consumed Maximum Stack Consumed  Units
IAR_M3 32 32 8-bit bytes
GCC_M3 39 39 8-bit bytes
TI_M3 32 32 8-bit bytes
GCC_M4 39 159 8-bit bytes
IAR_M4 32 152 8-bit bytes
TI_M4 32 112 8-bit bytes
GCC_M4F 111 303 8-bit bytes
IAR_M4F 104 296 8-bit bytes
TI_M4F 104 256 8-bit bytes
MSP430X 32 88 8-bit bytes
TI_C28_float 51 115 16-bit words
TI_C28_large 39 89 16-bit words
GCC_A9F 271 591 8-bit bytes
TI_A8Fnv 244 524 8-bit bytes
GCC_AS8F 251 571 8-bit bytes
GCC_a15F 271 591 8-bit bytes
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Target Minimum Stack Consumed Maximum Stack Consumed  Units
TI_ARP32 96 224 8-bit bytes
TI_ARP32_far 96 224 8-bit bytes
TI_C674 300 628 8-bit bytes
TI_C66 300 628 8-bit bytes

When a Task is preempted, a task stack may be required to contain either two interrupting Hwi contexts
(if the Task is preempted by a Hwi) or one interrupting Hwi context and one Task preemption context (if
the Task is preempted by a higher-priority Task). Since the Hwi context is larger than the Task context,
the numbers given are for two Hwi contexts. If a Task blocks, only those registers that a C function must
save are saved to the task stack.

Another way to find the correct stack size is to make the stack size large and then use Code Composer
Studio software to find the stack size actually used.

For C7000 targets, a special Task stack size constraint applies. The size available for use by the Task is
8 KB smaller than the size allocated. Also, the stack size is truncated using the stack’s alignment of 8 KB,
and the stack pointer may point only to a location that is a multiple of this alignment. This size reduction
occurs because a separate Task Context Save Pointer (TCSP) stack for use in processing interrupts is
placed in the top portion of the block allocated for each Task stack. The C7000 hardware requires that

the TCSP stack size be 8 KB and have an alignment of 8 KB. Since the Task stack effectively contains 2
stacks, both with a minimum size of 8 KB, the minimum size to allocate for a Task stack is 16 KB.

See Section 3.4.2 for information about system stack use by Hwis and Section 3.5.3 for information about
system stack size.

3.6.4  Testing for Stack Overflow
When a task uses more memory than its stack has been allocated, it can write into an area of memory
used by another task or data. This results in unpredictable and potentially fatal consequences. Therefore,
a means of checking for stack overflow is useful.
By default, the Task module checks to see whether a Task stack has overflowed at each Task switch. To
improve Task switching latency, you can disable this feature the Task.checkStackFlag property to false.
The function Task_stat() can be used to watch stack size. The structure returned by Task_stat() contains
both the size of its stack and the maximum number of MAUs ever used on its stack, so this code segment
could be used to warn of a nearly full stack:
Task_St at st at buf; /* declare buffer */
Task_stat (Task_sel f(), &statbuf); /* call func to get status */
if (statbuf.used > (statbuf.stackSize * 9/ 10)) {
System printf("Over 90% of task's stack is in use.\n")
}
See the Task_stat() information in the "ti.sysbios.knl" package documentation in the online
documentation.
You can use the Runtime Object View (ROV) to examine runtime Task stack usage.
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3.6.5 Task Hooks

The Task module supports the following set of Hook functions:

® Register. Afunction called before any statically created Tasks are initialized at runtime. The register
hook is called at boot time before main() and before interrupts are enabled.

® Create. Afunction called when a Task is created. This includes Tasks that are created statically and
those created dynamically using Task_create() or Task_construct(). The Create hook is called
outside of a Task_disable/enable block and before the task has been added to the ready list.

® Ready. A function called when a Task becomes ready to run. The ready hook is called from within a
Task_disable/enable block with interrupts enabled.

® Switch. A function called just before a task switch occurs. The 'prev' and 'next' task handles are
passed to the Switch hook. 'prev' is set to NULL for the initial task switch that occurs during
SYS/BIOS startup. The Switch hook is called from within a Task_disable/enable block with interrupts
enabled.

® Exit. Afunction called when a task exits using Task_exit(). The exit hook is passed the handle of the
exiting task. The exit hook is called outside of a Task_disable/enable block and before the task has
been removed from the kernel lists.

® Delete. Afunction called when a task is deleted at runtime with Task_delete().

The following HookSet structure type definition encapsulates the hook functions supported by the Task

module:

typedef struct Task_HookSet {
Void (*registerFxn)(Int); /* Regi ster Hook */
Voi d (*createFxn)(Handl e, Error.Block *); /* Create Hook */
Voi d (*readyFxn) (Handl e); /* Ready Hook */
Voi d (*swi tchFxn) (Handl e, Handl e); /* Switch Hook */
Voi d (*exitFxn)(Handl e); /* Exit Hook */
Voi d (*del et eFxn) (Handl e) ; /* Del ete Hook */

b

When more than one hook set is defined, the individual hook functions of a common type are invoked in
hook ID order.

Task hook functions can only be configured statically.

3.6.5.1 Register Function

The Register function is provided to allow a hook set to store its corresponding hook ID. This ID can be
passed to Task_setHookContext() and Task_getHookContext() to set or get hook-specific context. The
Register function must be specified if the hook implementation needs to use Task_setHookContext() or
Task_getHookContext().

The registerFxn function is called during system initialization before interrupts have been enabled.

The Register function has the following signature:

Voi d registerFxn(lnt id);
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3.6.5.2 Create and Delete Functions

The Create and Delete functions are called whenever a Task is created or deleted. The Create function
is passed an Error_Block that is to be passed to Memory_alloc() for applications that require additional
context storage space.

The createFxn and deleteFxn functions are called with interrupts enabled (unless called at boot time or
from main()).

These functions have the following signatures.

Voi d creat eFxn(Task_Handl e task, Error_Block *eb);
Voi d del et eFxn( Task_Handl e t ask);

3.6.5.3 Switch Function

If a Switch function is specified, it is invoked just before the new task is switched to. The switch function
is called with interrupts enabled.

This function can be used for purposes such as saving/restoring additional task context (for example,
external hardware registers), checking for task stack overflow, and monitoring the time used by each task.

The switchFxn has the following signature:

Voi d sw tchFxn(Task_Handl e prev, Task_Handl e next);

3.6.5.4 Ready Function

If a Ready Function is specified, it is invoked whenever a task is made ready to run. The Ready Function
is called with interrupts enabled (unless called at boot time or from main()).

The readyFxn has the following signature:

Voi d readyFxn(Task_Handl e task);

3.6.5.5 Exit Function

If an Exit Function is specified, it is invoked when a task exits (via call to Task_exit() or when a task returns
from its' main function). The exitFxn is called with interrupts enabled.

The exitFxn has the following signature:

Voi d exit Fxn(Task_Handl e t ask);

3.6.5.6 Task Hooks Example

The following example application uses a single Task hook set. This example demonstrates how to read
and write the Hook Context Pointer associated with each hook set.

The configuration script and program output are shown after the C code listing.

This is the C code for the example:

| * ======== TaskHookExarrp| e.C ========
* This exanpl e denonstrates basic task hook processing
* operation for dynamically created tasks. */
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#
#
#
#
#

ncl ude <xdc/std. h>

ncl ude <xdc/runtime/Error. h>
ncl ude <xdc/runtine/ Menory. h>
ncl ude <xdc/runtine/ System h>
ncl ude <xdc/runtime/ Types. h>

#
#

ncl ude <ti/sysbi os/ Bl CS. h>
ncl ude <ti/sysbi os/knl/ Task. h>

Task_Handl e nyTsk0, nyTskl, nyTsk2;
I nt nyHookSet|d, myHookSet| d2;

/* HookSet functions */

[ * ======== nyRegi ster ========

* invoked during SwM nodul e startup before main()

* for each HookSet */

Voi d nyRegi ster(Int hookSetl d)

{
System printf("myRegi ster: assigned HookSet Id = %\ n",
nmyHookSet | d = hookSet I d;

[ * ======== nyCreate ========

* invoked during Task_create for dynamically

* created Tasks */

Voi d nyCreate(Task_Handl e task, Error_Bl ock *eb)

{
String name;
Ptr pEnv;

name
pEnv

Task_Handl e_nane(t ask);
Task_get HookCont ext (t ask, nyHookSet1d);

hookSet | d) ;

System printf("myCreate: task nane = '%', pEnv = Ox%\n", nane, pEnv);

Task_set HookCont ext (t ask, myHookSetld, (Ptr)Oxdead);

[ * ======== nyReady ========

* invoked when Task is nade ready to run */

Voi d nyReady( Task_Handl e t ask)

{
String nane;
Ptr pEnv;
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name = Task_Handl e_nane(t ask);
pEnv = Task_get HookCont ext (t ask, nyHookSetld);

System printf("nmyReady: task name = '%', pEnv = Ox%\n", nane, pEnv);
Task_set HookCont ext (t ask, myHookSetld, (Ptr)OxcOde);

| * ======== WS\M tch ========
* invoked whenever a Task switch occurs/is nade ready to run */
Voi d nySwi t ch(Task_Handl e prev, Task_Handl e next)

{
String prevNane;
String next Nane;
Ptr pPrevEnv,
Ptr pNext Env;,
if (prev == NULL) {
Systemprintf("mySw tch: ignoring dunmry 1st prev Task\n");
}
el se {
prevNane = Task_Handl e_nane(prev);
pPrevEnv = Task_get HookCont ext (prev, myHookSetld);
Systemprintf("mySwitch: prev nane = '%', pPrevEnv = Ox%\n",
prevNane, pPrevEnv);
Task_set HookCont ext (prev, myHookSetld, (Ptr)OxcafecOde);
}
next Name = Task_Handl e_nane(next);
pNext Env = Task_get HookCont ext (next, nyHookSetl d);
System printf(" next name = '9%', pNextEnv = Ox%\n",
next Nane, pNext Env);
Task_set HookCont ext (next, nyHookSetld, (Ptr)0Oxc00lcOde);
}
| * ======== n‘yEx|t —=—==—==—==

* invoked whenever a Task calls Task_exit() or falls through
* the bottomof its task function. */
Voi d nyExit(Task_Handl e task)

{
Task_Handl e cur Task = task;
String nane;
Ptr pEnv;
nanme = Task_Handl e_nane( cur Task);
pEnv = Task_get HookCont ext (cur Task, nyHookSet1d);
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Systemprintf("nmyExit: curTask name = '%', pEnv = Ox%\n", nane, pEnv);
Task_set HookCont ext (cur Task, myHookSetld, (Ptr)Oxdeadbeef);
}
| * ======== rry[):_xl ete ========
* invoked upon Task deletion */
Voi d nyDel et e( Task_Handl e task)
{
String nane;
Ptr pEnv;
nane = Task_Handl e_nane(t ask);
pEnv = Task_get HookCont ext (t ask, nyHookSetld);
System printf("nyDel ete: task nane = '%', pEnv = Ox%\n", nane, pEnv);
}
/* Define 3 identical tasks */
Voi d nyTskOFunc(UArg arg0, UArg argl)
{
System printf("nmyTskO Entering\n");
System printf("nmyTskO Calling Task_yield\n");
Task_yi el d();
System printf("nmyTskO Exiting\n");
}
Voi d nyTsklFunc(UArg arg0, UArg argl)
{
System printf("nmyTskl Entering\n");
System printf("nmyTskl Calling Task_yield\n");
Task_yi el d();
System printf("nmyTskl Exiting\n");
}
Voi d nyTsk2Func(UArg arg0, UArg argl)
{
System printf("nmyTsk2 Entering\n");
System printf("nmyTsk2 Calling Task_yield\n");
Task_yi el d();
System printf("nmyTsk2 Exiting\n");
}
* ==== mai n */
Int main(lnt argc, Char* argv[])
{
Task_Par ans par ans;
Error_Bl ock eb;
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Error _init(&eb);
Task_Parans_i ni t (&par ans) ;
par ans. i nst ance- >name = "nyTsk0";
nyTsk0 = Task_creat e(nyTskOFunc, &parans, &eb);
if (nmyTskO == NULL) {
System abort ("nyTskO create failed");
}
par ans. i nst ance- >nanme = "nyTskl";
nyTskl = Task_create(nyTsklFunc, &parans, &eb);
if (nmyTskl == NULL) {
System abort ("nyTskl create failed");
}
par ans. i nst ance- >name = "nyTsk2";
nyTsk2 = Task_creat e(nyTsk2Func, &parans, &eb);
if (nmyTsk2 == NULL) {
System abort ("nyTsk2 create failed");
}
BI CS start();
return (0);
}
| * ======== n‘y| dl eFunc ======== */
Voi d nyl dl eFunc()
{
System printf("Entering idleFunc().\n");
Task_del et e( &y TskO) ;
Task_del et e( &y Tskl);
Task_del et e( &y Tsk2);
System exit(0);
}
The configuration script is as follows:
/* Lots of Systemprintf() output requires a bigger bufSize */
SysM n = xdc. useMdul e(' xdc. runtinme. SysMn');
SysM n. buf Si ze = 4096;
var ldle = xdc. useMdul e('ti.sysbios.knl.ldle");
I dl e. addFunc(' &yl dl eFunc');
var Task = xdc. useMdul e('ti.sysbhios. knl. Task");
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/* Enabl e i nstance nanes */
Task. conmon$. nanmed| nst ance = true;
/* Define and add one Task Hook Set */
Task. addHookSet ( {
regi ster Fxn: ' &yRegister',
createFxn: '&nyCreate',
readyFxn: ' &myReady',
swi tchFxn: ' &ySwitch',
exitFxn: '&myExit',
del eteFxn: '&nyDel ete',
1
The program output is as follows:
nyRegi ster: assigned HookSet 1d = 0
nyCreate: task nanme = 'ti.sysbios. knl. Task.|dl eTask', pEnv = 0x0
nyReady: task nane = 'ti.sysbios. knl.Task.ldl eTask', pEnv = Oxdead
nyCreate: task name = 'nyTskO', pEnv = 0x0
nyReady: task nanme = 'nyTsk0', pEnv = Oxdead
nyCreate: task name = 'nyTskl', pEnv = 0x0
nyReady: task nanme = 'nyTskl', pEnv = Oxdead
nyCreate: task name = 'nyTsk2', pEnv = 0x0
nyReady: task nanme = 'nyTsk2', pEnv = Oxdead
nySwi tch: ignoring dummy 1st prev Task
next nane = 'nyTsk0', pNextEnv = OxcOde
nyTskO Entering
nyTskO Cal ling Task_yield
nySwi tch: prev name = 'nyTsk0', pPrevEnv = 0xc001lcOde
next nanme = 'nyTskl', pNextEnv = OxcOde
nyTskl Entering
nyTskl Cal ling Task_yield
nySwi tch: prev nane = 'nyTskl', pPrevEnv = 0Oxc00lcOde
next name = 'nyTsk2', pNextEnv = 0OxcOde
nyTsk2 Entering
nyTsk2 Cal ling Task_yield
nySwi tch: prev nane = 'nyTsk2', pPrevEnv = 0Oxc001lcOde
next name = 'nyTsk0', pNextEnv = OxcafecOde
nyTskO Exiting
nyExit: curTask nane = 'nyTsk0', pEnv = 0xc001cOde
nySwi tch: prev name = 'nyTsk0', pPrevEnv = Oxdeadbeef
next name = 'nyTskl', pNextEnv = OxcafecOde
nyTskl Exiting
nyExit: curTask nane = 'nyTskl', pEnv = 0xc001cOde
nySwi tch: prev nanme = 'nyTskl', pPrevEnv = Oxdeadbeef
next name = 'nyTsk2', pNextEnv = OxcafecOde
nyTsk2 Exiting
nyExit: curTask nane = 'nyTsk2', pEnv = 0xc001cOde
nySwi tch: prev name = 'nyTsk2', pPrevEnv = Oxdeadbeef
next name = 'ti.sysbios.knl.Task.|dl eTask', pNextEnv = 0OxcOde
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3.6.6

Entering idl eFunc().

nyDel ete: task name = 'nyTskQ', pEnv = OxcafecOde
nyDel ete: task name = 'nyTskl', pEnv Oxcaf ecOde
nyDel ete: task name = 'nyTsk2', pEnv Oxcaf ecOde

Task Yielding for Time-Slice Scheduling

Example 3-1 demonstrates a time-slicing scheduling model that can be managed by a user. This model
is preemptive and does not require any cooperation (that is, code) by the tasks. The tasks are
programmed as if they were the only thread running. Although SYS/BIOS tasks of differing priorities can
exist in any given application, the time-slicing model only applies to tasks of equal priority.

In this example, a periodic Clock object is configured to run a simple function that calls the Task_yield()
function every 4 clock ticks. Another periodic Clock object is to run a simple function that calls the
Semaphore_post() function every 16 milliseconds.

The output of the example code is shown after the code.

Example 3-1 Time-Slice Scheduling

* ======== slice.c ========

* This exanple utilizes time-slice scheduling anong three
* tasks of equal priority. A fourth task of higher

* priority periodically preenpts execution.

* A periodic Cock object drives the tinme-slice scheduling.
* BEvery 4 mlliseconds, the C ock object calls Task_yield()
* which forces the current task to relinquish access to

* to the CPU

* Because a task is always ready to run, this program

* does not spend tine in the idle loop. Calls to Idle_run()
* are added to give time to the Idle Ioop functions

* occasionally. The call to Idle_run() is within a

* Task_di sabl e(), Task_restore() block because the call

* to Idle_run() is not reentrant.

#
#
#

ncl ude <xdc/std. h>
ncl ude <xdc/runti me/ System h>
ncl ude <xdc/runtine/ Error. h>

#
#
#
#i
#i
#i

ncl ude <ti/sysbi os/ Bl CS. h>

ncl ude <ti/sysbi os/knl/ Semaphore. h>
ncl ude <ti/sysbi os/knl/d ock. h>

ncl ude <ti/sysbi os/knl/d ock. h>

ncl ude <ti/sysbhios/knl/1dle.h>

ncl ude <ti/sysbi os/ knl/ Task. h>

#i

ncl ude <xdc/ cfg/ gl obal . h>
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Voi d hi Pri Task(UArg arg0, UArg argl);
Voi d task(UArg arg0, UArg argl);

Voi d cl ockHandl er 1(UArg arg);

Voi d cl ockHandl er2(UArg arg);
Semaphor e_Handl e sem

* ==== mai n */
Voi d mai n()
{

Task_Parans taskPar ans;
Task_Handl e nyTsk0, nyTski;
Cl ock_Parans cl ockPar ans;

Cl ock_Handl e nyd k0, nyd k1;
Error Bl ock eb;

unt i;

Systemprintf("Slice exanple started!\n");

Error_init(&eb);

/* Create 1 task with priority 15 */
Task_Parans_i ni t (& askPar ans) ;
t askPar ans. st ackSi ze = 512;

/1 Note: Larger stack needed for some targets, including ' C6748

taskParans. priority = 15;

nyTsk0 = Task_create((Task_FuncPtr)hi Pri Task, &taskParans, &eb);

if (nyTskO == NULL) {
System abort ("hi Pri Task create failed");
}

/* Create 3 tasks with priority 1 */

/* re-uses taskParans */

taskParans. priority = 1;

for (i =0; i <3; i++) {
taskParans.arg0 = i;

nyTski = Task_create((Task_FuncPtr)task, &t askParans, &eb);

if (nyTski == NULL) {
System abort ("LoPri Task % create failed",

}

i);
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/ *
* Create clock that calls Task_yield() every 4 Cock ticks
*/

Cl ock_Parans_i nit (&cl ockPar ans) ;
cl ockParans. period = 4;/* every 4 Cock ticks */
cl ockParans. startFlag = TRUE;/* start immediately */
nyC kO = O ock_create((C ock_FuncPtr)cl ockHandl er1, 4, &clockParans, &eb);
if (nmyd kO == NULL) {
System abort ("Cl ockO create failed");

}

/*
* Create clock that calls Senaphore_post() every
* 16 dock ticks
*/
cl ockParans. period = 16;/* every 16 O ock ticks */
cl ockParans. startFlag = TRUE;/* start immediately */
nyC k1 = O ock_create((C ock_FuncPtr)cl ockHandl er2, 16, &cl ockParans, &eb);
if (nmydkl == NULL) {
System abort ("Cl ockl create failed");

}

/*
* Create semaphore with initial count = 0 and default parans
*/
sem = Semaphore_create(0, NULL, &eb);
if (sem== NULL) {
System abort (" Semaphore create failed");

}
/* Start SYS/BICS */
Bl OS_start();

}

| * ======== ¢| ockHandl er 1 ======== */

Voi d cl ockHandl er 1(UArg arg)

{
/* Call Task_yield every 4 ns */
Task_yi el d();

}

| * ======== ¢| ockHandl| er 2 ======== */

Voi d cl ockHandl er 2( UArg arg)

{
/* Call Semaphore_post every 16 ns */
Semaphor e_post (sem ;

}
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[* ==== task */
Voi d task(UArg arg0, UArg argl)
{

Int tinme;
Int prevtinme = -1;
U nt taskKey;

/* While loop simulates work | oad of tinme-sharing tasks */
while (1) {
time = dock_getTicks();

/* print tine once per clock tick */
if (time >= prevtine + 1) {
prevtine = tineg;
Systemprintf("Task %: tinme is %@\n", (Int)arg0, tine);

/* check for rollover */
if (prevtime >tinme) {
prevtine = tineg;

}

/* Process the Idle Loop functions */
taskKey = Task_disabl e();

Idle_run();

Task_restore(taskKey);

| * ======== hj Pri Task ======== */
Voi d hi Pri Task(UArg arg0, UArg argl)
{

static Int nunilines = 0;

while (1) {

System printf("hiPri Task here\n");

if (++nunifines < 3) {
Semaphor e_pend(sem BI OS_WAI T_FOREVER) ;

}

el se {
Systemprintf("Slice exanple ending.\n");
System exit(0);
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The System_printf() output for this example is as follows:
Slice exanple started!
hi Pri Task here
Task 0: timeis O
Task O0: tine is 1
Task O0: tine is 2
Task O0: tine is 3
Task 1. tine is 4
Task 1: tine is 5
Task 1: tine is 6
Task 1. tine is 7
Task 2: tine is 8
Task 2: tine is 9
Task 2: tinme is 10
Task 2: tinme is 11
Task 0: tinme is 12
Task 0: tine is 13
Task 0: time is 14
Task 0: tinme is 15
hi Pri Task here
Task 1: tine is 16
Task 1: tinme is 17
Task 1: tine is 18
Task 1: tine is 19
Task 2: time is 20
Task 2: tinme is 21
Task 2: tinme is 22
Task 2: tinme is 23
Task 0: time is 24
Task 0: tinme is 25
Task 0: tinme is 26
Task 0: tinme is 27
Task 1: tinme is 28
Task 1: tinme is 29
Task 1: time is 30
Task 1: tinme is 31
hi Pri Task here
Slice exanpl e ending

SPRUEX3V—June 2020 Threading Modules 99

Submit Documentation Feedback



http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SPRUEX3V
http://www.ti.com

13 TEXAS

INSTRUMENTS
The Idle Loop www.ti.com
3.7 The ldle Loop
The Idle Loop is the background thread of SYS/BIOS, which runs continuously when no Hwi, Swi, or Task
is running. Any other thread can preempt the Idle Loop at any point.
The Idle manager allows you to insert functions that execute within the Idle Loop. The Idle Loop runs the
Idle functions you configured. Idle_loop calls the functions associated with each one of the Idle objects
one at a time, and then starts over again in a continuous loop.
Idle threads all run at the same priority, sequentially. The functions are called in the same order in which
they were created. An Idle function must run to completion before the next Idle function can start running.
When the last idle function has completed, the Idle Loop starts the first Idle function again.
Idle Loop functions are often used to poll non-real-time devices that do not (or cannot) generate
interrupts, monitor system status, or perform other background activities.
The Idle Loop is the thread with lowest priority in a SYS/BIOS application. The Idle Loop functions run
only when no Hwis, Swis, or Tasks need to run.
The CPU load and thread load are computed in an Idle loop function. (Data transfer for between the target
and the host is handled by a low-priority task.)
If you configure Task.enableldleTask to be false, no Idle task is created and the Idle functions are not run.
If you want a function to run when there are no other threads ready to run, you can specify such a function
using Task.allBlockedFunc.
If you want the Idle Loop to run without creating a dedicated Idle task, you can disable
Task.enableldleTask and configure Task.allBlockedFunc as follows. These statements cause the Idle
functions to be run using the stack of the last Task to pend.
Task. enabl el dl eTask = fal se;
Task. al | Bl ockedFunc = I|dl e.run;
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3.8

Example Using Hwi, Swi, and Task Threads

This example depicts a stylized version of the SYS/BIOS Clock module design. It uses a combination of
Hwi, Swi, and Task threads.

A periodic timer interrupt posts a Swi that processes the Clock object list. Each entry in the Clock object
list has its own period and Clock function. When an object's period has expired, the Clock function is
invoked and the period restarted.

Since there is no limit to the number of Clock objects that can be placed in the list and no way to

determine the overhead of each Clock function, the length of time spent servicing all the Clock objects is
non-deterministic. As such, servicing the Clock objects in the timer's Hwi thread is impractical. Using a
Swi for this function is a relatively (as compared with using a Task) lightweight solution to this problem.

The configuration script and program output are shown after the C code listing. This is the C code for the
example:

i ncl ude <xdc/std. h>
i ncl ude <xdc/runtinme/System h>
ncl ude <xdc/runtinme/Error. h>

®* H

#

#
#
#
#
#
#

ncl ude <ti/sysbi os/ Bl CS. h>

ncl ude <ti/sysbi os/hal/Tiner. h>

ncl ude <ti/sysbi os/ knl/ Semaphore. h>
ncl ude <ti/sysbi os/knl/Sw . h>

ncl ude <ti/sysbi os/ knl/ Task. h>

ncl ude <ti/sysbi os/ knl/ Queue. h>

#

ncl ude <xdc/ cf g/ gl obal . h>

typedef struct {
Queue_El em el em
U nt32 tinmeout;
U nt 32 peri od;
Void (*fxn)(UArg);
UArg arg;

} O ock_Object;

Cl ock_Obj ect clkl, clk2;
Ti mer _Handl e tiner;
Senmaphor e_Handl e sem
Swi _Handl e swi ;
Task_Handl e t ask;
Queue_Handl e cl ockQueue;

/* Here on Timer interrupt */

Voi d hwi Fxn(UArg arg)

{
Swi _post (swi);

}
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7T SWm thread to handl e Tiner rnterrupt </

Void swi Fxn(UArg argl, UArg arg2)

{
Queue_El em *el em
Cl ock_QObj ect *obj;

/* point to first clock object in the clockQueue */
el em = Queue_next ((Queue_El em *) cl ockQueue) ;

/* service all the Cock Objects in the clockQeue */
while (elem!= (Queue_El em *)cl ockQueue) {
obj = (O ock_Object *)el em

/* decrenent the tineout counter */
obj - >ti meout -= 1;

/* if period has expired, refresh the timeout
* val ue and invoke the clock func */
if (obj->tinmeout == 0) {
obj - >ti neout = obj - >peri od;
(obj ->fxn) (obj ->arg);
}

/* advance to next clock object in clockQueue */
el em = Queue_next (el enm;

}

/* Task thread pends on Semaphore posted by d ock thread */
Voi d taskFxn(UArg argl, UArg arg2)

{
System printf("lIn taskFxn pendi ng on Senpahore.\n");
Semaphor e_pend(sem Bl OS_WAI T_FOREVER) ;
Systemprintf("lIn taskFxn returned from Senpahore.\n");
System exit(0);

}

/* First Clock function, invoked every 5 timer interrupts */

Voi d cl k1Fxn(UArg arg)

{
Systemprintf("lIn clklFxn, arg = %l.\n", arg);
cl k1. ar g++;

}

/* Second C ock function, invoked every 20 tinmer interrupts */

Voi d cl k2Fxn(UArg sen

{
System printf("lIn cl k2Fxn, posting Semaphore.\n");
Semaphor e_post (( Semaphor e_Obj ect *)sen);

}

/* main() */

Int main(lnt argc, char* argv[])

{
Ti mer _Par ans tinerParans;
Task _Parans taskPar ans;
Error Bl ock eb;
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System printf("Starting Hu Swi Task exanmple.\n");

Error _init(&eb);
Ti mer _Parans_i ni t (& i mer Par ans) ;
Task_Parans_i ni t (& askPar ans) ;

/* Create a SWi with default priority (15).
* Swi handler is 'swiFxn' which runs as a Swi thread. */
SWi = Swi _create(sw Fxn, NULL, &eb);
if (swi == NULL) {
System abort("Sw create failed");

}

/* Create a Task with priority 3.
* Task function is 'taskFxn' which runs as a Task thread. */
taskParans. priority = 3;
task = Task_create(taskFxn, &t askParans, &eb);
if (task == NULL) {
System abort (" Task create failed");

}

/* Create a binary Semaphore for exanple task to pend on */
sem = Senmaphore_create(0, NULL, &eb);
if (sem== NULL) {

System abort (" Semaphore create failed");

}

/* Create a Queue to hold the dock hjects on */
cl ockQueue = Queue_creat e(NULL, &eb);
if (clockQueue == NULL) {

System abort (" Queue create failed");

}

/* setup clkl to go off every 5 timer interrupts. */
cl k1. fxn = cl k1Fxn;

cl kl. period = 5;

cl kl.timeout = 5;

clkl.arg = 1;

/* add the O ock object to the cl ockQueue */
Queue_put (cl ockQueue, &cl kl.elem;

/* setup clk2 to go off every 20 tinmer interrupts. */
cl k2. fxn = cl k2Fxn;

cl k2. period = 20;

cl k2. timeout = 20;

clk2.arg = (UArg)sem

/* add the O ock object to the cl ockQueue */
Queue_put (cl ockQueue, &cl k2.elem;
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7= Confrgure a pertrodic rTnterrupt using any avallable Ti1ner
* with a 1000 m crosecond (1ns) interrupt period.
*
* The Timer interrupt will be handl ed by 'hw Fxn' which
*will run as a HM thread.
*/
ti mer Parans. peri od = 1000;
timer = Timer_create(Tinmer_ANY, hw Fxn, &timnerParans, &eb);
if (tinmer == NULL) {

System abort ("Timer create failed");

}
Bl OS_start();

return(0);

}

The configuration script is as follows:

| * ======== HW Swi TaskExan"p| e. cf g ======== */

var Defaults = xdc.useMdul e(’' xdc. runtinme. Defaults');
var Di ags = xdc. useMdul e(' xdc. runti ne. Di ags');

var Error = xdc.useMdul e(' xdc. runtine.Error');

var Log = xdc. useModul e(' xdc. runtine. Log');

var LoggerBuf = xdc.uselModul e(' xdc. runti ne. Logger Buf');
var Main = xdc. useMdul e(' xdc. runtinme. Main');

var Menory = xdc.useMdul e(' xdc. runti nme. Menory')

var SysM n = xdc. useMdul e(' xdc. runti me. SysMn');

var System = xdc. useMdul e(' xdc. runti me. System );

var Text = xdc.useMdul e(' xdc. runtinme. Text');

var Timer = xdc.useMdul e('ti.sysbios.hal.Tiner');

var BI OGS = xdc. useMdul e('ti.sysbhios.BICS);

var C ock = xdc.useMdul e('ti.sysbios.knl.d ock');

var Task = xdc.useMdul e('ti.syshios. knl. Task');

var Semaphore = xdc.useMdul e('ti.sysbhios. knl. Semaphore');
var Queue = xdc.useMdul e('ti.sysbios. knl.Qeue');

var HmM = xdc.useModul e('ti.sysbios.hal.Hwi'");

var HeapMem = xdc. useModul e('ti.sysbi os. heaps. HeapMenm ) ;

Program argSi ze = 0x0;
Syst em maxAt exi t Handl ers = 4;
Bl CS. heapSi ze = 0x2000;

/* System stack size (used by ISRs and Swis) */
Program stack = 0x1000;

/* Circular buffer size for Systemprintf() */
SysM n. buf Si ze = 0x400;
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var | ogger Buf Parans = new Logger Buf . Par ans() ;

| ogger Buf Par ans. nunEntries = 32;

var | ogger0 = Logger Buf. creat e(l ogger Buf Par ans) ;
Def aul t s. conmon$. | ogger = | ogger 0;

Mai n. common$. di ags_| NFO = Di ags. ALMAYS_ON,

Syst em Support Proxy = SysM n;
Bl CS. i bType = BI CS. Li bType_Cust om

INSTRUMENTS
www.ti.com Example Using Hwi, Swi, and Task Threads
/* Create and install |ogger for the whole system*/

The program output is as follows:

Starting Hw Swi Task exanpl e.

I n taskFxn pendi ng on Senaphore.
In cl k1Fxn, arg =
In cl k1Fxn, arg =
In cl k1Fxn, arg =
In cl klFxn, arg = 4.

In cl k2Fxn, posting Senaphore.

In taskFxn returned from Senaphore

W
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41 Semaphores

SYS/BIOS provides a fundamental set of functions for inter-task synchronization and communication
based upon semaphores. Semaphores are often used to coordinate access to a shared resource among
a set of competing tasks. The Semaphore module provides functions that manipulate semaphore objects
accessed through handles of type Semaphore_Handle. See the video introducing Semaphores for an
overview.

Semaphore objects can be declared as either counting or binary semaphores and as either simple (FIFO)
or priority-aware semaphores. Semaphores can be used for task synchronization and mutual exclusion.
The same APIs are used for both counting and binary semaphores.

By default, semaphores are simple counting semaphores.

Counting semaphores keep an internal count of the number of corresponding resources available. When
count is greater than 0, tasks do not block when acquiring a semaphore. The count value for a semaphore
is limited only by the size of the 16-bit counter. If Asserts are disabled, the count rolls over with no
notification if the count is incremented from the maximum 16 bit value.

To configure a counting semaphore, set the mode parameter as follows:

senPar ans. node = Semaphor e_Mde_COUNTI NG,

Binary semaphores are either available or unavailable. Their value cannot be incremented beyond 1.
Thus, they should be used for coordinating access to a shared resource by a maximum of two tasks.
Binary semaphores provide better performance than counting semaphores.

To configure a binary semaphore, set the mode parameter as follows:

senPar ans. node = Senmaphor e_Mdde_BI NARY;

Tasks wait for simple counting and binary semaphores in FIFO order without regard to the priority of the
tasks. Optionally, you can create "priority" semaphores that insert pending tasks into the waiting list
before the first task that has a lower priority. As a result, tasks of equal priority pend in FIFO order, but
tasks of higher priority are readied before tasks of lower priority.

To configure a counting or binary priority semaphore, set the mode parameter using one of the following
constants:

senPar ans. node = Semaphor e_Mde_CCOUNTI NG_PRI ORI TY;

senPar ans. node = Senaphor e_Mde_BI NARY_PRI ORI TY;

Note that using priority semaphores can increase the interrupt latency in the system, since interrupts are
disabled while the list of tasks waiting on the semaphore is scanned for the proper insertion point. This
is typically about a dozen instructions per waiting task. For example, if you have 10 tasks of higher priority
waiting, then all 10 will be checked with interrupts disabled before the new task is entered onto the list.

For information about the parameter structure and individual parameters for instances of this module, see
the API Reference Help System described in Section 1.6.1.
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The functions Semaphore_create() and Semaphore_delete() are used to create and delete semaphore
objects, respectively, as shown in Example 4-1. You can also create semaphore objects statically.

Example 4-1 Creating and Deleting a Semaphore

Semaphor e_Handl e Sermaphore_cr eat e(

I nt count,
Senmaphor e_Par ans *attrs
Er r or _Bl ock *eb );

Voi d Sermaphor e_del et e( Semaphore_Handl e *sen);

The semaphore count is initialized to count when it is created. In general, count is set to the number of
resources that the semaphore is synchronizing.

Semaphore_pend() waits for a semaphore. If the semaphore count is greater than 0, Semaphore_pend()
simply decrements the count and returns. Otherwise, Semaphore_pend() waits for the semaphore to be
posted by Semaphore_post().

The timeout parameter to Semaphore_pend(), as shown in Example 4-2, allows the task to wait until a
timeout, to wait indefinitely (BIOS_WAIT_FOREVER), or to not wait at all (BIOS_NO_WAIT).
Semaphore_pend()’s return value is used to indicate if the semaphore was acquired successfully.

Example 4-2 Setting a Timeout with Semaphore_pend()

Bool Semaphore_pend(
Senmaphor e_Handl e sem
Ul nt tinmeout);

Example 4-3 shows Semaphore_post(), which is used to signal a semaphore. If a task is waiting for the
semaphore, Semaphore_post() removes the first task from the semaphore queue and puts it on the ready
queue. If no tasks are waiting, Semaphore_post() simply increments the semaphore count and returns.

Example 4-3 Signaling a Semaphore with Semaphore_post()

| Voi d Sermaphor e_post ( Semaphor e_Handl e sem;

Calling Semaphore_post() may result in hardware interrupts being re-enabled in specific circumstances.
See Section 8.2.4, Enabling and Disabling Interrupts for details.
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Semaphore Example

Example 4-4 provides sample code for three writer tasks that create unique messages and place them
on a list for one reader task. The writer tasks call Semaphore_post() to indicate that another message

has been put on the list. The reader task calls Semaphore_pend() to wait for messages.

Semaphore_pend() returns only when a message is available on the list. The reader task prints the

message using the System_printf() function.

The three writer tasks, a reader task, a semaphore, and a queue in this example program were created

statically as follows:

var Defaults = xdc.useMdul e(' xdc. runtinme. Defaults');
var Di ags = xdc.useMdul e(' xdc. runtime. Di ags');

var Error = xdc.useMdul e(' xdc.runtime.Error');

var Log = xdc.useModul e(' xdc. runtine. Log');

var LoggerBuf = xdc.useMdul e(' xdc. runti nme. LoggerBuf');
var Main = xdc.useMdul e(' xdc. runtime. Main');

var Menmory = xdc.useMdul e(' xdc. runtime. Menory')

var SysMn xdc. useModul e(' xdc. runti me. SysMn');

var System = xdc.useMdul e(' xdc. runtime. System );

var Text = xdc.useMdul e(' xdc.runtime. Text");

var Bl OGS = xdc. useMdul e('ti.sysbhios.BICS);

var C ock = xdc.useMdul e('ti.sysbios.knl.d ock');

var Task = xdc.useMdul e('ti.sysbhios. knl. Task');

var Senmaphore = xdc.useMdul e('ti.sysbhios. knl. Semaphore');
var HwM = xdc. useModul e('ti.sysbios.hal.Hwi'");

var HeapMem = xdc. useModul e('ti.sysbi os. heaps. HeapMen ) ;

/* set heap and stack sizes */
Bl CS. heapSi ze = 0x2000;
Program stack = 0x1000;
SysM n. buf Si ze = 0x400;

/* set library type */
Bl CS. | i bType = BICS. Li bType_Cust om

/* Set |ogger for the whole system*/

var | ogger Buf Parans = new Logger Buf . Par ans() ;

| ogger Buf Par ans. nunEntries = 32;

var | oggerO = Logger Buf. creat e(l ogger Buf Par ans) ;
Def aul t s. conmon$. | ogger = | ogger 0;

Mai n. conmon$. di ags_| NFO = Di ags. ALWAYS_ON;

/* Use Semaphore, and Task nmodul es and set gl obal properties */
var Semaphore = xdc.uselModul e('ti.sysbios. knl. Senaphore');
Program gl obal . sem = Semaphore. create(0);

var Task = xdc.useMdul e('ti.sysbios. knl. Task');

Task. i dl eTaskVi tal TaskFl ag = fal se;
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/* Statically create reader and witer Tasks */
var reader = Task.create(' & eader');
reader.priority = b5;

var witer0O = Task.create(' &witer');
writerQ.priority = 3;
writer0Q.arg0 = O;

var witerl = Task.create('&witer');
witerl.priority = 3;
witerl.arg0 = 1;

var witer2 = Task.create(' &witer');
witer2.priority = 3;
witer2.arg0 = 2;

/* uses Queue nodul e and create two instances statically */
var Queue = xdc.useMdul e('ti.sysbios. knl.Qeue');

Program gl obal . mrsgQueue = Queue.create();

Program gl obal . freeQueue = Queue.create();

Since this program employs multiple tasks, a counting semaphore is used to synchronize access to the
list. Figure 4-1 provides a view of the results from Example 4-3. Though the three writer tasks are
scheduled first, the messages are read as soon as they have been put on the queue, because the
reader’s task priority is higher than that of the writer.

Example 4-4 Semaphore Example Using Three Writer Tasks

| * ======== sentest.Cc ======== */

#i ncl ude <xdc/std. h>

#i ncl ude <xdc/runti me/ Menory. h>

#i ncl ude <xdc/runti me/ System h>

#i ncl ude <xdc/runtime/Error. h>

#i ncl ude <ti/sysbi os/BI CS. h>

#i ncl ude <ti/sysbi os/knl/ Semaphore. h>
#i ncl ude <ti/sysbi os/knl/Task. h>

#i ncl ude <ti/sysbi os/knl/ Queue. h>

#defi ne NUMVSGS 3 /* nunber of nessages */
#define NUMARI TERS 3 /* nunber of witer tasks created with */

/* Config Tool */
typedef struct MsgObj {

Queue_El em el em /* first field for Queue */
Int id; /* witer task id */
Char val; /* nmessage val ue */

} MegQbj, *Msg;

Voi d reader();
Void witer();
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/* The following objects are created statically. */
extern Semaphore_Handl e sem
extern Queue_Handl e nmsgQueue;
extern Queue_Handl e freeQueue;
[* ==== mai n */
Int main(lnt argc, Char* argv[])
{
Int i;
MsgQbj *nsg;
Error_Bl ock eb;
Error_init(&eb);
msg = (Msgbj *) Menory_all oc(NULL, NUMVBGS * sizeof (Msglbj), 0, &eb);:
if (msg == NULL) {
System abort ("Menory allocation failed");
}
/* Put all nessages on freeQueue */
for (i = 0; i < NUMBGS;, nsg++, i++) {
Queue_put (freeQueue, (Queue_Elem*) nsgQ);
}
BI CS start();
return(0);
}
| * ======== reader ======== */
Voi d reader ()
{
Veg nsg;
Int i;
for (i = 0; i < NUMBGS * NUMARI TERS; i++) {
/* Wait for semaphore to be posted by witer(). */
Semaphor e_pend(sem BI GS_WAI T_FOREVER) ;
/* get nessage */
nsg = Queue_get (nsgQueue);
/* print value */
Systemprintf("read '%' from (%).\n", nsg->val, nsg->id);
/* free nmsg */
Queue_put (freeQueue, (Queue_Elem*) nsQ);
}
System printf("reader done.\n");
}
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| * ======== witer ======== */
Void witer(Int id)
{
Veg Nnsg;
Int i;
for (i = 0; i < NUMBGS; i++) {
/* Get nsg fromthe free list. Since reader is higher
* priority and only blocks on sem list is never
* empty. */
nsg = Queue_get (freeQueue);
/* fill in value */
nsg->id = id;
nsg->val = (i & Oxf) + 'a';
Systemoprintf("(%) witing '%' ...\n", id, nsg->val);
/* put nessage */
Queue_put (nsgQueue, (Queue_El em *) nsQ);
/* post semaphore */
Senmaphor e_post (sem ;
}
Systemprintf("witer (%) done.\n", id);
}
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Figure 4-1. Trace Window Results from Example 4-4

(0) witing 'a'
read 'a' from (0).
(0) witing 'b'
read 'b" from (0).
(0) witing 'c'
read 'c' from (0).
writer (0) done.
(1) witing 'a'
read 'a' from(1).
(1) witing '"b" ...
read 'b" from(1).
(1) witing 'c'
read 'c' from(1).
witer (1) done.
(2) witing 'a'
read 'a' from(2).
(2) witing 'b" ...
read 'b' from(2).
(2) witing 'c'
read 'c' from(2).
reader done.

witer (2) done.

Event Module

Events provide a means for communicating between and synchronizing threads. They are similar to
Semaphores (see Section 4.1), except that they allow you to specify multiple conditions ("events") that
must occur before the waiting thread returns.

An Event instance is used with calls to "pend" and "post", just as for a Semaphore. However, calls to
Event_pend() additionally specify which events to wait for, and calls to Event_post() specify which events
are being posted.

Note: Only a single Task can pend on an Event object at a time.

A single Event instance can manage up to 32 events, each represented by an event ID. Event IDs are
simply bit masks that correspond to a unique event managed by the Event object.

Each Event behaves like a binary semaphore. However, see Section 4.2.1 for details about events that
are implicitly posted from a Semaphore or Mailbox.

For information about the parameter structure and individual parameters for instances of this module, see
the API Reference Help System described in Section 1.6.1.

A call to Event_pend() takes an "andMask" and an "orMask". The andMask consists of the event IDs of
all 